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Chapter 1  
 
 

HEC-WAT (Watershed Analysis Tool) 
 
 
1.1 Introduction 
 
The U.S. Army Corps of Engineers (USACE) conducts water resources management studies.  
These studies begin with the definition of problems, issues, and opportunities and continue 
through the planning process by formulating, evaluating, and comparing alternatives with 
various analyses to determine impacts so that appropriate decisions may be made.  The studies 
often require hydrologic, hydraulic, economic, and social impact analyses.  In most cases, 
varying sections within a USACE office or through a Project Delivery Team (PDT) perform 
these impact analyses independently with the reporting and visualization of modeling results 
through independent models.  For the project study, coordination, file/data sharing, logistics, 
reporting of modeling results, and status reporting are often a problem for the modeling teams as 
well as project management. 
 
The Institute for Water Resources, Hydrologic Engineering Center (CEIWR-HEC) developed the 
Watershed Analysis Tool (HEC-WAT) to meet the USACE requirements of performing water 
resources studies in a comprehensive, systems based approach. Modeling teams will benefit 
because teams will be able to develop models in a closely coordinated manner using a shared 
schematic; track progress of other models; and, automatically retrieve results from previous 
model runs through the shared schematic, thus assuring a more efficient and coordinated result.  
A graphical user interface (GUI) would allow data and results sharing, common schematic 
assembly, definition and representation of alternatives, model setup, editing and implementation, 
and direct data and results visualization.  The management team would benefit through the use of 
a tool that employs a common interface by being able to track project status through each 
modeling component and being able to display results during public and project status meetings. 
 
For over two decades, USACE has required that all USACE planning processes address the 
Nation's water resources needs in a systems context while using risk analysis.  From within 
USACE there is very little guidance and few tools to support this requirement.  For this reason, 
HEC has added an option to HEC-WAT that will analyze complex riverine systems while 
implementing the flood risk management and systems requirements.  The new compute option, 
Flood Risk Analysis (FRA), will allow a user to perform plan formulation or system 
performance analyses while incorporating risk analysis. 
 
HEC-WAT provides a framework that streamlines and integrates tools commonly applied by 
USACE District and Division offices used when performing a water resources management 
study. The basic building block of the HEC-WAT framework is an HEC developed concept 
labeled "plug-in". By using the plug-in concept HEC-WAT incorporates individual pieces of 
software such as: 
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 HEC-RAS - River Analysis System 
 HEC-HMS - Hydrologic Modeling System 
 HEC-ResSim - Reservoir Simulation 
 HEC-FIA - Flood Impact Analysis 
 HEC-SSP - Statistical Software Package 
 HEC-DSSVue -HEC Data Storage System (DSS) Visual Utility Engine 
 
The plug-in allows the software to work together in a coordinated fashion so that water 
resources, and economic decisions can be made from the same interface. 
 
1.2 Purpose 
 
The purpose of the HEC-WAT software is to help USACE study teams perform the necessary 
hydrologic, hydraulic, and consequence planning analyses that is required for water resource 
studies. The HEC-WAT framework allows a multi-disciplinary PDT to perform water resources 
studies in a comprehensive, systems based approach by building, editing and running models 
commonly applied by multi-disciplinary teams and saving and displaying data and results in a 
coordinated fashion.   
 
The terminology, analysis procedures, and output used by HEC-WAT are consistent with the 
requirements of USACE guidance and policy.  HEC-WAT is designed to facilitate: 
 
 ● The entry of the appropriate data into each of the individual modeling programs. 
 
 ● Trade-off analyses as all study alternatives will eventually be created within the HEC-

WAT using consistent schematics, data, and tools.  Their results will be easier to compare 
and contrast thus making the trade-off analysis easier to perform. 

 
 ● The analytical process and enhanced coordination among study team members, while 

producing more consistent results, and shared displays. 
 
 ● The definition of alternatives through schematic representations, model identification and 

sequencing, and tabular formats. 
 
 ● The study status by reviewing reports in the HEC-WAT.  During any given study, the 

manager or any other member of the project delivery team (PDT) will be able to determine 
the study status. 

 
 ● The reviewing of modeling results at all modeled locations without the direct knowledge 

of how any of the individual models develop those results.  Those attending meetings will 
be able to see the results directly rather than reading the results from a few locations in a 
hard copy report or poster. 
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Chapter 2  
 
 

Installing HEC-WAT 
 
 
2.1 Requirements 
 

• Installation - about 3 GB of hard disk space for HEC-RAS 5.0.3 and HEC-WAT; 
Russian River watershed data about 10 GB; HEC-WAT Russian River watershed 
about 3 GB 

 
• Memory - 6 GB 
 
• Operating System - Windows XP 64-bit, Windows 7, and Windows 10. 
 
• Java - HEC-WAT runs Java 8, which is included and run under the HEC-WAT 

installation folder  
 
2.2 Installation 
 

• Install HEC-WAT using the self-extracting exe file (i.e., C:\Programs) -  
 "HEC-WAT_10_Portable.exe". 

 
• HEC- RAS Install - If HEC-RAS Version 5.0.3 has not been installed on your 

computer, located in C:\Programs\....\HEC-WAT-10_Portable\apps) is a 
shortcut.  Double-click on the shortcut and the user will be directed to the HEC-
RAS download webpage. 

 
• Install the Russian River Watershed using the zip file - "Russian_WAT.7z". 
 
• Install the Russian River folder using the zip file - "RussianRiver_Data.7z". 
 
• To create an HEC-WAT shortcut, from the HEC-WAT directory, right click on 

"wat.exe" and drag to the desktop.  Release, and from the shortcut menu click 
Create shortcuts here, an HEC-WAT shortcut will appear. 

 
2.3 Starting HEC-WAT 
 
When starting HEC-WAT, double-click the HEC-WAT icon (shortcut) on your desktop.  The 
splash dialog box (Figure 2.1) for HEC-WAT will open and will appear for a few seconds, and 
then the main window of HEC-WAT will appear (Figure 2.2).  HEC-WAT is now ready for use. 
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Figure 2.1  HEC-WAT Splash Dialog Box 
 
 

 
Figure 2.2  HEC-WAT Main Window 
 
2.4 About the Quick Start Guide 
 
Chapters 3 thru 5 provide the user with an overview of the HEC-WAT framework. Chapter 6 introduces 
the user to creating an HEC-WAT study from scratch.  Chapters 7 thru 9 are standalone chapters that lead 
a user thru creating an HEC-WAT study by importing individual models (Chapter 7); importing a CWMS 
watershed (Chapter 8); and, creating an HEC-WAT study that incorporates a simple flood FRA compute. 
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Chapter 3  
 
 

HEC-WAT Overview 
 
HEC-WAT is software that orchestrates the building, editing, and running of a series of models 
to help perform water resources studies and address the requirements found in USACE guidance.  
The software provides flexibility to offices in the performance of water resources studies (Figure 
3.1). The software can be used to perform small CAP (Continuing Authorities Program) studies 
or large comprehensive studies.  The HEC-WAT interface streamlines and integrates the 
analytical process of water resource studies by using the tools commonly applied by multi-
disciplinary teams.  These tools include hydrologic, hydraulic, economic, and social impact 
assessments. 
 

 
Figure 3.1  HEC-WAT Study 
 
The HEC-WAT tool allows USACE and its partners and stakeholders to conduct their studies in 
a coordinated fashion.  Coordination begins as each model uses the common schematic that is 
built within the HEC-WAT interface.  The common schematic demands that each team use the 
same nomenclature for each of their models and alternatives.  The individual models can be built 
and edited inside or outside the HEC-WAT and model results are viewed from HEC-WAT by 
selecting the elements found on the schematic.  Once the models are located within HEC-WAT, 
the models can be run in sequence.  The storage of data is organized by DSS and a simple DSS 
linking device is used to connect the models.  The models themselves, the input data, and the 
results are all stored in the HEC-WAT's directory structure.   
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Therefore, all data and files used to make decisions are easily retrieved.  Alternative analyses can 
be performed, and output from multiple alternatives can be viewed at the same time making 
alternative analyses and selection easier. 
 
3.1 Identifying a Study 
 
An issue at the beginning of any project study (i.e., reconnaissance, or feasibility) is the 
definition, study extent, and representation of alternatives, initially the without project, base year 
alternative.  HEC-WAT helps to address this issue by allowing the project study team to jointly 
define alternatives through schematic representations, model identification and sequencing, and 
tabular formats. 
 
The study team, under the direction of a Project Manager (PM), will start by meeting to acquaint 
the team with the location of the study to be conducted, and, then defining the problems and 
looking for opportunities.  A typical study team could be composed of a PM, GIS (Geographic 
Information System) specialist, hydrologist, hydraulic engineer, water manager (reservoir), 
economist (flood damage and other consequence such as life loss), biologist (water quality), and 
planner. 
 
After the location of the watershed, and the problems and opportunities of the study have been 
identified, the team will start the analytical process by determining what data or models already 
exist and what data and models will need to be built.  Unlike the CWMS (Corps Water 
Management System) software that automatically extracts or copies data for a DSS file before a 
simulation is computed, HEC-WAT has no such requirements.  Therefore, if the study requires 
the use of observed data, historical, or other model data, this data needs to be stored in DSS files.  
This requirement is based on the way HEC-WAT links model alternatives together and 
simulations are computed. 
 
With a map in hand, the PM would lead the study team on choosing the study boundaries, 
identifying gage locations, sub-basin delineations, points where models would share data 
(common computation points), damage area centers, and location of measures (reservoirs, levees, 
etc.).  Once this information has been identified then someone from the study team would be 
chosen to set up the base alternative (Without Project Conditions).  This person should be 
someone with knowledge of the study area. 
 
With the study area defined, the study team needs to identify any models that may already exist, 
what data is available, and what is the time window (analysis period) for the base alternative 
(Without Project Conditions).  Once the base alternative is set the study team could identify, 
name, and gather information for additional alternatives.  These alternatives could include the 
use of additional flood risk management measures, environmental features, or represent future 
conditions.  The benefit of HEC-WAT is that each of the modeling teams will be able to use the 
identical schematic to perform their modeling and naming will be consistent across all models.   
 
Each alternative will be tied to a given schematic.  Therefore, the alternative definitions will be 
fully coordinated making for more consistent modeling and results. 
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3.2 Creating a Study 
 
After the study team has identified the study area, an HEC-WAT study can be created (Figure 
3.1).  A study, in HEC-WAT is a combination of the data and models and events required to 
analyze a specific geographic area.  The first step is to define the schematic for the base 
alternative, and then schematics for other defined alternatives. 
 
A schematic is a physical representation of a stream alignment, and the flood risk management 
and environmental measures that will be modeled.  One individual from the study team will build 
the schematic for the base alternative.  The first basic item of an HEC-WAT schematic is the 
stream alignment; this is usually created from importing information from a map layer 
(shapefile).  Once a stream alignment has been built, then using the drawing tools available from 
within HEC-WAT, common computation points, and existing flood control or restoration 
measures, can be added to the schematic that will be shared across all models.  To aid in the 
placement of elements on the schematic, background maps of gage locations, reservoir locations, 
sub-basin delineations, study boundary areas, etc. could be added to the study. 
 
By default, HEC-WAT creates the base alternative – Without Project Conditions first.  The study 
team has probably defined other alternatives that can be created, as well.  An alternative in 
HEC-WAT is a way to group a schematic with different operations and model parameters.  Once 
an alternative is created, the next step is to create analysis periods.  Analysis periods define the 
time window and events that could be associated with an alternative are generated using time 
window modifiers.  An event is an occurrence of precipitation/snowmelt that leads to some sort 
of hydrologic response normally associated with a specific time period.  The event can be 
historical or hypothetical or represent the upper limit of a precipitation runoff response. 
 
Now that alternatives and analysis periods have been defined, existing models that have been 
identified can be brought into the HEC-WAT study either by importing or copying the files into 
the HEC-WAT directory structure.  If models are to be built, the HEC-WAT provides two 
options.  One is that the models can be created through HEC-WAT by accessing the individual 
pieces of software directly from the framework.  The other option is to copy the files created by 
HEC-WAT to a computer, and then return the files to the HEC-WAT study (Chapter 4, Section 
4.6) once the models are calibrated.  For example, if the HEC-RAS model for a study needs to be 
built, from the HEC-WAT directory structure there is a HEC-RAS folder which contains the 
default HEC-RAS files for the study.  Copy these files to a computer, create the HEC-RAS 
model, and then copy the files back to the HEC-WAT study. 
 
Once all the models have been added to the HEC-WAT study, simulations can be created.  A 
simulation is a combination of an analysis period and event(s) associated with an alternative.  
For each of these combinations, models will need to be selected, the simulation will be 
computed, and results will be reviewed.  The process is then repeated for the other identified 
alternatives, and after several HEC-WAT simulations, alternative result comparisons can be 
reviewed. 
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3.3 Opening a Study 
 
 1. From the HEC-WAT main window (Figure 3.1), from the File menu, click Open Study. 

The Open Study Browser (Figure 3.2) will open. 
 

 
Figure 3.2  HEC-WAT - Open Study Browser 

 
 2. Browse to the location of the provided HEC-WAT study (i.e., C:\Users\xxxxxxxx\ 
  Desktop\Russian_WAT).  The Look in list will show the location that is being chosen. 

Click on the .sty file - RussianRiver.sty.  The File Name box will now contain the .sty 
file name.  The Files of Type list should display Wat Studies. 

 
 3. Click Open, the Open Study Browser will close (Figure 3.2) and the HEC-WAT main 

window (Figure 3.3) will now display the selected study - RussianRiver. 
 

 
Figure 3.3  HEC-WAT Main Window - RussianRiver Study 
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Chapter 4  
 
 

HEC-WAT Interface 
 
 
The HEC-WAT main window (Figure 4.1) displays the framework for the HEC-WAT software 
that allows users to enter data, review data, create alternatives, run simulations, and view results.  
The Title Bar (Figure 4.1) displays the HEC-WAT study title.  After a study is opened, the name 
of the study will appear here.   
 

 
Figure 4.1  HEC-WAT Main Window 
 
4.1 Panes 
 
The HEC-WAT main window (Figure 4.1) is laid out in panes that allow the user to view HEC-
WAT study data at the same time or to display different, yet simultaneous, views of the study 
data.  The HEC-WAT main window has four main panes.  The panes are: 
 
 Study Pane Provides an overview of items that have been defined for an HEC-WAT 

study (Figure 4.2).  Based on the view (Section 4.2), the Study Pane can 
display information about alternatives; simulations; analysis periods; models 
that have been defined for the study; what map windows are actively open; 
the available schematics; stream alignments; measures; common computation 
points; and, impact areas. 
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Figure 4.2  Study Pane - Study View 

 
 Content Pane This pane provides details on selected HEC-WAT components (Figure 4.3) 

in the Study Pane (available in the study, maps, and schematic views; see 
Section 4.2).  For example, in Figure 4.3, for a study view, an HEC-WAT 
simulation has been selected – Without Project Conditions-RR_Feb_1986.  
The Content Pane displays the elements of the selected simulation.  
Information includes the alternative, the analysis period, the program order 
being used, the model alternatives that were run, the time window, the 
directory where the results from the simulation were written, and the status of 
the simulation.  For a map view, the Content Pane displays the layers (map 
layers, primary layers) associated with the selected map windows listed in the 
Study Pane. 

 

 
Figure 4.3  Content Pane - Study View 

 



HEC-WAT Quick Start Guide Chapter 4 - HEC-WAT Interface 

 4-3 

 Desktop Pane The Desktop Pane (Figure 4.4) is where the different map windows 
available from HEC-WAT will display.  For example, in Figure 4.4, the 
Desktop Pane contains a map window of a selected simulation and a map 
window of a selected schematic.  These two map windows provide the user 
with a graphical representation of a simulation and a schematic, respectively.   

 

 
Figure 4.4  Desktop Pane 

 
 Message Pane The Message Pane (Figure 4.5) contains messages that the HEC-WAT 

software is providing for informational purposes.  The information in the 
Message Pane is a record of HEC-WAT software activities, recording the 
opening of a study, opening map windows, accessing DSS, and many other 
HEC-WAT activities. 

 

 
Figure 4.5  Message Pane 

 
4.2 Tabs 
 
HEC-WAT tabs provide different views of the available data in a 
study and users can perform certain operations for a study from the 
tabs.  The tabs can change the layout of the menu bar; and, available information in the Study 
and Content panes can change.  There are three tabs: 
 
 Study The default tab (Figure 4. 2) which provides a view of the study data in a tree 

(study tree) in the Study Pane.  Also, from the Study Tree a user can create, 
edit, and delete alternatives, analysis periods, and simulations.  From the 
Content Pane (Figure 4.3) the user can view detailed information about items 
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listed in the Study Tree.  Also, this view affects the HEC-WAT menu bar 
(Section 4.3) 

 
 Maps This tab (Figure 4.6) provides a view (Maps View) of the map windows 

currently active in the Desktop Pane (Figure 4.4).  The maps windows are 
displayed by type in the Study Pane portion.  In the Content Pane portion 
(Figure 4.6) information about the layers for a selected map window are 
displayed.  Also, from the Content Pane in the Maps View the user can turn 
layers on/off, adjust properties of the layers, and order the layers for viewing in 
the associated map window.  When the user switches to the Maps View the 
HEC-WAT menu bar options will change. 

 

 
Figure 4.6  Maps Tab 

 
 Schematic From this tab (Figure 4.7), the user is provided with a view (a tree) in the Study 

Pane of the map layers that are available in the study, schematics that have been 
defined for the study, and, available components - stream alignments, measures 
(levees, reservoirs), common computation points, and impact areas that have 
been defined for the study.  Also, from the study tree, the user can create, edit, 
delete, and modify the elements in the Schematic View.  In the Content Pane 
further information is provided about elements in the Schematic View.  When 
the user switches to the Schematic View the HEC-WAT menu bar options will 
change. 

 
4.3 Menu Bar 
 
The menu bar of HEC-WAT provides the user with many commands to perform various 
functions.  For further details on each command for the available menus, review the HEC-WAT 
User's Manual. For this manual, an overview of each menu that is available in the HEC-WAT 
software is provided. 
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Figure 4.7  Schematic Tab 
 
The File menu allows the user to perform study management functions such as creating, opening, 
closing, and saving an HEC-WAT study.  Also, provides commands that will allow users to 
provide information about the study team; select the software applications or tools (plug-ins) that 
are needed for the study; import a CWMS watershed; import other HEC software application's 
model alternatives (HEC-HMS, HEC-ResSim, HEC-RAS, HEC-ResSim); open recently viewed 
HEC-WAT studies; and, exit the HEC-WAT software.  This menu is available in all HEC-WAT 
views. 
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From the Edit menu, the HEC-WAT users can create/modify/edit items that are the building 
blocks of an HEC-WAT study. A user can manipulate alternatives and simulations; establish the 
program order for a study; link the individual models of a study; modify the look and feel of the 
common computation point layers (CCPs); provide aliases for defined stream segments in the 
HEC-WAT study; access available FRA editors; and, access editors from the individual 
application software and tools that are part of a study.  This menu is available in all HEC-WAT 
views. 
 
The View menu is where an HEC-WAT user can setup the HEC-WAT main window.  The user 
can select which toolbars and panes to display and not display; set display units for plotting and 
tabulating; save layouts of the HEC-WAT framework; select which common computation point 
layer to view; and, review a report of the CCPs by common computation point layer in the HEC-
WAT study.  This menu is available in all HEC-WAT views. 
 
From the Maps menu the user can setup map layers and map windows for the HEC-WAT study.  
Commands include setting up spatial properties; adding and removing map layers; manipulate 
map windows; add an Internet map; print a copy of the active map window in the Desktop Pane 
(Figure 4.4); and, import and export schematic elements (i.e., stream alignment, common 
computation points).  This menu is available in all HEC-WAT views. 
 
The Compute menu is used to compute individual simulations; compute multiple simulations; 
view a list of simulations for the watershed that have been computed; compute the active 
simulation or compute the individual models of the active simulation; and, view the compute log 
for the active simulation.  This menu is only available in the Study View. 
 
From the Results menu the user can view the simulation DSS file which contains data from a 
simulation; and, results from the software applications that are part of the active study.  This 
menu is only available in the Study View. 
 
The Tools menu provides access to DSS data (HEC-DSSVue); access to the Statistical Software 
Package (HEC-SSP); provides options for HEC-WAT startup, setting system properties, viewing 
threads, setup simulation and compute color, and plug-in information; view the log for HEC-
WAT; view the logs that display DSS file activity and the logs of the applications software; 
monitor memory usage; what graphic elements HEC-WAT knows about from the other 
applications; information on how the different model alternatives are used for the study; and, 
setup for Distributed Computing.  This menu is available in all HEC-WAT views. 
 
From the Window menu the HEC-WAT user can control the appearance of the map windows in 
the Desktop Pane (Figure 3.1) of the HEC-WAT main window.  This menu is available in all 
HEC-WAT views. 
 
From the Help menu the user can access HEC-WAT documentation (i.e., HEC-WAT User's 
Manual, HEC-WAT Quick Start Guide), install the example study, connect to the HEC-WAT 
webpage, connect to the HEC website, and display current version information about HEC-
WAT. 
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4.4 Map Windows 
 
Map windows (Figure 4.4) in HEC-WAT provide a way to graphically display HEC-WAT 
components.  Map windows are displayed in the Desktop Pane of the HEC-WAT interface.  
There are three types of map windows available in HEC-WAT - schematic, alternative, and 
simulation.  The HEC-WAT User's Manual provides more detailed information on map 
windows. 
 
4.5 Plug-Ins 
 
The primary purpose of HEC-WAT is to streamline and integrate a water resources study using 
software commonly applied by multi-disciplinary teams.  The integration of the models is 
accomplished through the use of a concept called a "plug-in".  By using plug-ins, HEC-WAT 
can incorporate individual pieces of software (HEC-RAS, HEC-HMS, HEC-ResSim, HEC-FIA) 
into the HEC-WAT framework which allows the individual software applications to work 
together in a coordinated fashion so that water resources, and economic decisions can be made 
from the same interface.  For further details on plug-ins, review the HEC-WAT Technical 
Reference Manual which will be available after the release of Version 1.0. 
 
To view the HEC-WAT default plug-ins: 
 
 1. From the HEC-WAT main window (Figure 4.1), from the Tools menu, click Options. 
 
 2. The Options dialog box (Figure 4.8) will open. Click on the Plug-ins tab. The table that 

is displayed provides information on all of the current plug-ins that are available in  
  HEC-WAT. 
 

 
Figure 4.8  HEC-WAT - Options Dialog Box - Plug-ins Tab 

 
 4. Click OK, the Options dialog box will close (Figure 4.8). 
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To select the plug-ins for a study: 
 
 1. From the HEC-WAT main window (Figure 4.1), from the File menu, click Study 

Details. 
 
 2. The Study Details dialog box (Figure 4.9) will open. This dialog box provides 

information about the active study, allows the user to manipulate map windows; contact 
information for the study team; information on the model alternatives that make up the 
study; information about study simulations, and the plug-ins that are used by the study 
 

 
Figure 4.9  Study Details Dialog Box – Plugins Tab 

 
 3. Click on the Plug-ins tab. By enabling or disabling the plug-ins listed, the user will 

define what plug-ins will be used for the active study. 
 
 4. Click OK, the Study Details dialog box (Figure 4.9) will close. 
 
4.6 Directory Structure 
 
Once an HEC-WAT study has been created, a directory structure has been created at a location 
the user selected when creating a HEC-WAT study.  Figure 4.10 is a snapshot that represents the 
HEC-WAT directory structure for the RussianRiver study.  More information on this directory 
structure and the individual files is provided in Chapter 4 of the HEC-WAT User's Manual. 
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Figure 4.10  HEC-WAT Example Directory Structure 
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Chapter 5  
 
 

Reviewing Results 
 
To view model results in HEC-WAT, at least one simulation map window should be open in the 
Desktop Pane.  Results will display for the active simulation map window by the model 
alternatives that are associated with the simulation.  Results are available either from the HEC-
WAT main window (Figure 4.1), from the Study Tree by simulation, from the Content Pane, or 
interactively from the schematic of the current simulation map window. 
 
5.1 Results Menu 
 
From the HEC-WAT Results menu the user can access reports from the different models.  From 
the HEC-WAT main window (Figure 4.1), from the Results menu, the user will point to the 
model from which the user wants to view results for. For example, if the user points to HMS, 
points to the HEC-HMS model alternative (that is part of selected simulation), click on Global 
Summary Table, the Global Summary Results for report for that particular HEC-HMS run 
will display (Figure 5.1). 
 

 
Figure 5.1  HMS - Global Summary Report 
 
For HEC-RAS, from the Results menu, point to RAS, click Plot XYZ 3-D, the X-Y-Z 
Perspective Plot dialog box will open (Figure 5.2). 
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Figure 5.2  RAS - X-Y-Z Perspective Plot 
 
5.2 Content Pane 
 
Once a simulation has been computed, 
the user can also get the same reports 
that are available from the Results menu 
from the Content Pane. From the 
Content Pane right-click on one of the 
available models, from the shortcut 
menu (Figure 5.3), point to Results, 
click on the results that are available. 
 
For example, in Figure 5.3, from the 
Content Pane right-click on the HEC-
ResSim calibrate model, from the 
shortcut menu point to Results, click 
Flow Summary.  The HEC-ResSim 
Flow Summary Report dialog box will 
open (Figure 5.4). 
 Figure 5.3  Content Pane - Shortcut Menu - Results 
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Figure 5.4  ResSim - Flow Summary Report - Russian River 
 
For HEC-FIA results, right-click on the HEC-FIA GridsAndXSecsAlternative model, from the 
shortcut menu point to Results, click Individual Structure Damage Report.  The HEC-FIA 
Individual Structure Damage Report will open (Figure 5.5). 
 

 
Figure 5.5  FIA - Individual Structure Damage Report 
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5.3 Schematic 
 
Results from the schematic are available by right-clicking on schematic elements and from the 
shortcut menu select result items (zooming in on an area is a good idea).  From the map window 
click the Pointer Tool     , right-click on a schematic element, a shortcut menu will appear 
(Figure 5.6).  For example (Figure 5.6), right-click on a junction, the shortcut menu (Figure 5.6), 
besides providing information about the junction, HEC-WAT also provides information on 
schematic elements that are around the junction, like impact area, routing reaches, and cross 
sections. 
 

 
Figure 5.6  HEC-WAT Schematic Shortcut Menu 
 
In the example (Figure 5.6), if the user right-clicks on a junction from the shortcut menu, point to 
Impact Area, click Aggregated Consequence Report, the HEC-FIA Aggregated 
Consequence Report will open (Figure 5.7). Click the Life Loss tab to get a Life Loss Report 
by impact areas.  
 

 
Figure 5.7  FIA - Aggregated Consequence Report - Life Loss Report 
 
From the same location in Figure 5.6, from the shortcut menu point to Reach, click Profile Plot, 
and the HEC-RAS Profile Plot (Figure 5.8) is displayed. 
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Figure 5.8  RAS - Profile Plot 
 
Also at that location (Figure 5.6), from the shortcut point to Reach, click Graph, and the HMS 
graph for that HMS routing reach (Figure 5.9) is displayed. 
 

 
Figure 5.9  HMS - Graph of HEC-HMS Routing Reach 
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Chapter 6  
 
 

Create an HEC-WAT Study from Scratch 
 
Chapters 3 - 5 provided the user with an overview of the HEC-WAT framework. This chapter 
provides the user with instructions on creating an HEC-WAT study from scratch.   
 
6.1 Create an HEC-WAT Study 
 
To create a new study: 
 
 1. From the HEC-WAT main window (Figure 6.1), on the File menu, click New Study. The 

Create New Study dialog box (Figure 6.2) will open. 
 

 
Figure 6.1  HEC-WAT Main Window 

 
 2. In the Study Name box (Figure 6.2), enter a name (RussianRiver), and in the 

Description box, enter a description (Russian River water resources study) for the new 
study. 

 
 3. In the Directory box (Figure 6.2), either enter the name of the directory where to store 

the HEC-WAT study, or click     , and an Open browser (Figure 6.3) will open.  Navigate 
to the directory where the HEC-WAT study will be stored, click Open.  The Open 
browser (Figure 6.3) will close. On the Create New Study dialog box (Figure 6.2) in the 
Directory box the location will display. 
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Figure 6.2  Create New Study Dialog Box 

 
 

 
Figure 6.3  Open Browser 

 
 4. The Unit System (Figure 6.2) for the study defaults to English (which is correct for the 

RussianRiver study).  The other choice from the list is SI (metric). 
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 5. Next, the projected coordinate system of the study needs to be set.  From the Create New 
Study dialog box (Figure 6.2), click Edit (by the Coordinate System box), the Map 
Coordinate Information dialog box will open (Figure 6.4). 

 

 
Figure 6.4  Map Coordinate Information Dialog Box with Study Projection Information 

 
 6. For the RussianRiver study the associated map layers have the correct projected 

coordinate system.  So, one of those map layers can be used to set the projected 
coordinate system for the study.  From the Map Coordinate Information dialog box 
(Figure 6.4), click Load from file (lower left corner of dialog box); an Open browser 
(Figure 6.3) will open.  The map layers for the RussianRiver study are located in a folder 
titled RussianRiver_Data (double-click).  In that folder, is a MapLayers (double click) 
folder, from that folder, click on RR_StreamAlignment.prj (any of the map layers will 
work). Click Open, now the Map Coordinate Information dialog box will contain 
information about the projected coordinate system (Figure 6.4).  Click OK, the Map 
Coordinate Information dialog box will close (Figure 6.4).  Now on the Create New 
Study dialog box the Coordinate System box (Figure 6.2) contains the name of the 
projected coordinate system (i.e., USA_Continguous_Albers_Equal_Area_Conic_ 

  USGS_version) for the study. 
 
 7. When creating the RussianRiver study the user can add map layers that the PDT team has 

gathered for defining the study area.  From the Create New Study dialog box (Figure 
6.2), click Add Map Layers.  The Select Map to Add browser will open (Figure 6.5). 
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Figure 6.5  Select Map to Add Browser 

 
  To copy the map layers to the study directory area, from the Select Map to Add browser 

(Figure 6.5), select Create Copy.  Browse to where the map layers are located (in the 
folder titled RussianRiver_Data, double-click on Map Layers).  Select the following map 
layers: 

 
 ● Find the map layer that represents the stream alignment - RR_StreamAlignment.shp 
 ● Find the map layer the represents the subbasins - RussianSubbasins.shp 
 ● Find the map layer which represents the stream gages - Raingages_Albers_ft.shp 
 ● Find the map layer which represents the reservoirs - RR_Lakes_Albers_ft.shp 
 ● Find the map layer which represents the impact areas - RR_ImpactAreas.shp 
 ● Find the map layer which represents the CCPs - RR_CommonComputationPoints.shp 
 
  Click Open, the Select Map to Add browser will close (Figure 6.5).  The Create New 

Study dialog box (Figure 6.6) appears. 
 
 8. HEC-WAT creates a default alternative - Without Project Conditions.  If the user wants 

the default alternative to have a different name, several choices are available, including 
Other which allows the user to name the default alternative.  For the RussianRiver study 
the default alternative is used. 

 
 9. Click OK, the Create New Study dialog box will close (Figure 6.6).  The HEC-WAT 

main window will now have the name of the study (RussianRiver) on the title bar (Figure 
6.7).  A Schematic Map Window opens, which contains the map layers that were added 
to the study in Step 7. 
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Figure 6.6  Create New Study Dialog Box - Completed 

 
 

 
Figure 6.7  HEC-WAT Main Window - RussianRiver Study - Maps Tab 
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6.2 Building the Without Project Conditions 
Schematic 

 
HEC-WAT by default will create a default alternative Without Project Conditions (see Section 
6.1, step 8).  From the HEC-WAT main widow (Figure 6.8), the Schematic Map Window, will 
contain the initial schematic for the Without Project Conditions.  The next step is to build the 
schematic for the default alternative. 
 
6.2.1 Adjust Map Layers 
 
Once a map layer is in the HEC-WAT framework the user can make adjustments to the layer.  
Since the map layer that represents the subbasins for the RussianRiver study is a little bit in 
everyone's face, let's adjust that file - RussianSubbasins.shp. 
 
From the HEC-WAT main window, click the Maps tab (Figure 6.7).  Now the user can see 
which Map Window is currently active and what layers make up that Map Window.  To change 
the color and the fill aspects of the RussianSubbasins.shp do the following: 
 
 1. From the Map Layers tree (Figure 6.8), 

right click on RussianSubbasins.shp. This 
is the shapefile shortcut menu.  This 
shortcut menu allows the user to 
expand/collapse the RussianSubbasins.shp 
leaf; move the shapefile to different 
positions in the tree (Move To Top/Move 
To Bottom, Move up/Move Down); show 
the legend of the shapefile; change the 
label of the shapefile; edit the properties of 
the shapefile; set/remove scale factors; 
copy the map layer to another location; and 
open the attribute table of the shapefile. 

 
 2. From the shapefile shortcut menu (Figure 

6.8), click Properties, the Edit Polygon 
Properties dialog box will open (Figure 
6.9).  The RussianSubbasins.shp file is a 
polygon shapefile.  To edit the fill of the 
active map layer, from the Fill tab, change 
the color or not have a fill.  For the 
example in Figure 6.9, fill will be turned off.  So click Display Fill, the check mark will 
clear, meaning that fill is turned off. 

 
  To change the outline color of the subbasin layer, from the Edit Polygon Properties 

dialog box (Figure 6.9), click the Border tab. From the Color list, select a color 
("darkred").  Click OK, the Edit Polygon Properties dialog box will close and the 
changes will appear in dark red in the Map Window. 

 

Figure 6.8  Map Layers Tree - Shortcut Menu 
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Figure 6.9  Edit Polygon Properties Dialog Box 

 
 3. To turn off a map layer - click in the checkbox by Raingages_Albers_ft.shp, the rain 

gages no longer appear on the map window. 
 
 4. To display the map window zoomed in, select the Zoom Tool      . Draw a box around the 

map layers that are displayed in the Map Window.  From the Maps menu, click Default 
Map Properties, the Default Map Properties for dialog box will open (Figure 6.10).  
Click Set Map Extents to Display, click OK.  The Default Map Properties for dialog 
box will close. 

 

 
Figure 6.10  Default Map Properties for Dialog Box 

 
This sets the extents for the Map Window so that when the study is opened the next time the 
Map Window will be zoomed in to the tighter area. 
 
6.2.2 Create a Stream Alignment 
 
The backbone of any schematic is the stream alignment, and is the starting point in creating a 
schematic.  A stream alignment is a one-dimensional river coordinate system, which defines the 
natural downstream flow network.  Also, from the stream centerline, stationing will be provided 
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relative to its global location and specific to the study.  The alignment indicates where 
confluences and bifurcations occur and provides a sense of distance and scale.  Stream 
alignments are composed of a series of streams, stream nodes, and stream junctions. 
 
The PDT has discussed the extents of the main stem for the study and has included all of the 
tributaries that will be considered by all of the models in the study.  The PDT has created a 
shapefile that contains all of the pertinent streams - RR_StreamAlignment.shp 
 
To import a stream alignment: 
 
 1. From the Map Layers tree (Figure 6.8), right-click on Stream Alignment. From the 

shortcut menu, click Import.  The Import Stream Alignment dialog box will open 
(Figure 6.11).  The Shapefile Name list defaults to the first line shapefile it can find in 
the maps directory; which happens to be the shapefile that represents the stream 
alignment for the RussianRiver study - RR_StreamAlignment.shp. 

 

 
Figure 6.11  Import Stream Alignment Dialog Box 

 
 2. From the Database Field Name list (Figure 6.11), the user needs to select the field name 

in the attribute file that contains the names of the streams - Name.  Once a field name is 
selected, the table below will populate with the streams contained in the shapefile.  If 
there is an issue with any of the stream segments the checkbox in the Import column 
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(Figure 6.11) will not be selected.  This means the stream segment is not continuous and 
will not be imported. 

 
 3. Click Reverse Direction (Figure 6.11). The flow direction in the RR_StreamAlignment. 
  shp shapefile is not correct.  So instead of fixing the issue with ArcMap® (ESRI GIS 

software), by performing the Reserve Direction procedure the system of streams will 
have the correct flow direction. 

 
 4. Click Import, a message window will appear letting the user know that the stream 

alignment imported successfully.  Click OK, the Import Stream Alignment dialog box 
will close (Figure 6.11).  In the active Map Window the stream alignment appears 
(orange stream segments; green stream nodes and stream junctions). 

 
6.2.3 Add the Background Internet Map 
 
Knowing where the watershed is located in reference to known locations can be quite helpful 
when communicating with the PDT and stakeholders.  From the Maps menu (Figure 6.12), point 
to Add Internet Map, from the available list select which internet map that would be a good 
background (i.e., Open Street Map) map for the watershed.  The selected internet map will load 
and appear in the active Map Window. 
 

 
Figure 6.12  Maps Menu - Add Internet Map 
 
This layer in the background might help with adding additional streams to the stream alignment; 
locations of reservoirs, levees, other projects, impact areas, and common computation points 
(CCPs).  Based on the known extents of the study area, the layer provides a view of the 
watershed and surrounding area. 
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6.2.4 Adding CCPs 
 
Common computation points (CCPs) are locations where one model can transfer data to 
another model, a location where results are needed for model development or alternative 
analysis, or locations where input boundary conditions are to be defined.  CCPs need to be 
consistent for all models and should be placed on the stream alignment based on knowledge of 
possible study alternatives.  The entire study team should be involved in the definition of the 
common computation points. 
 
To import CCPs from a shapefile: 
 
 1. From Maps menu (Figure 6.12), point to Import, click Computation Points.  The 

Import Computation Points dialog box will open (Figure 6.13).  The Shapefile Name 
list defaults to the first point shapefile it can find in the maps directory; which happens to 
be the shapefile that represents the common computation points for the Russian River 
study - RR_CommonComputationPoints.shp. 

 

 
Figure 6.13  Import Computation Points Dialog Box 

 
 2. From the Database Field Name list (Figure 6.13), select the field name in the attribute 

file that contains the names of the CCPs - ID_Name.  Once a field name is selected, the 
table below will populate with the CCPs contained in the shapefile.  If there is an issue 
with any of the CCPs the checkbox in the Import column will not be selected.   

 
 3. Click Import, the Import Computation Points dialog box will close (Figure 6.13).  

Once the import of the CCPs is completed, a message window will appear letting you 
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know that the CCPs have been imported successfully.  In the active Map Window the 
CCPs appear as black circles. 

 
A user can also add CCPs to the schematic manually by performing the following steps: 
 
 1. From the Schematic Map Window, find the location where a CCP needs to be added, 

press the Computation Point Tool     . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the common 

computation point. 
 
 3. The Name New Computation Point dialog box will open (Figure 6.14).  Enter the new 

Name (required) and Description (optional, but recommended).  Click OK, the Name 
New Computation Point dialog box will close. 

 

 
Figure 6.14  Name New Computation Point Dialog Box 

 
 4. The common computation point will now appear in the map window as a black circle.  
 
 5. If a CCP is added at a stream junction, a slightly different Name New Computation 

Point dialog box will open (Figure 6.15).  Enter the new Name (required) and 
Description (optional, but recommended). 

 
 6. From the Select the Placement of the Computation Point list (Figure 6.15), determine 

exactly where the common computation point will be placed.  Choices are to have the 
common computation point placed on the stream junction, along one of the streams that 
form the stream junction, or none of the above.  For example, in Figure 6.15, the common 
computation point will be placed on the stream junction. 

 
 7. Click OK, the Name New Computation Point dialog box (Figure 6.15) will close.  The 

common computation point will now appear in the display area as a black circle. 
 
6.2.5 Adding a Reservoir 
 
A reservoir is the impoundment created behind dams, or behind navigation locks and dams.  For 
HEC-WAT a reservoir also includes the dam built on a stream to store water for uses such as 
flood risk management, hydroelectric power generation, recreation use, and water supply, etc. 
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Figure 6.15  Name new Computation Point Dialog Box at a Stream Junction 

 
To add a reservoir: 
 
 1. From the Schematic Map Window, find the location where a reservoir needs to be 

added, press the Reservoir Tool      . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the upstream end of 

the reservoir.  Release the CTRL key; drag the mouse to the downstream end of the 
reservoir and click. 

 
 3. The Name New Reservoir dialog box will open (Figure 6.16).  Enter the new Name 

(Lake Mendocino) and Description (optional, but recommended).  Click OK, the Name 
New Reservoir dialog box will close. 

 

 
Figure 6.16  Name New Reservoir Dialog Box 

 
 4. The reservoir will now appear on the schematic as a cyan triangle (reservoir pool), a blue 

line (storage reach), a gray rectangle (dam), and two common computation points that 
represent the upstream and downstream ends of the reservoir. 
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 5. The default representation of the reservoir pool is a triangle; the user can edit this triangle 
if a more detailed representation of the pool is desired.  With the Reservoir Tool pressed, 
double-click on the reservoir.  The triangle (Figure 6.17) will now be green with a blue 
outline color.  Also, there are three vertex points (blue), and at the apex of the triangle is 
the reservoir label, which is represented by a yellow circle. 

 

 
Figure 6.17  Reservoir Pool 

 
 6. When a reservoir is created there are two common computation points that are created 

with default names.  It is recommended that the names of the two common computation 
points be changed.  These two common computations points represent the inflow and 
outflow junctions of the reservoir and should be renamed accordingly. 

 
 7. To change the name of a common computation point, press the Computation Point Tool 
      , right-click on one of the common computation points.  From the shortcut menu, click 

Rename Computation Point; the Rename Computation Point dialog box will open 
(Figure 6.18).  In the Name box, enter the new name, and in the Description box enter a 
description (optional, but recommended).  For example, in Figure 6.18, the inflow 
junction for Lake Mendocino has been labeled Lake Mendocino Inflow Jct, and the 
outflow junction should be labeled Lake Mendocino Outflow Jct. 

 

 
Figure 6.18  Rename Computation Point Dialog Box 

 
 8. Click OK, a Confirm Rename window will open, asking the user to be sure that the 

CCP is to be renamed. Click Yes, the Rename Computation Point dialog box will close 
(Figure 6.18) and the new name for the CCP will appear in the map window. 

 
Repeat the steps above for the Lake Sonoma reservoir. 
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6.2.6 Adding Impact Areas 
 
An impact area is any distinct portion of a study that is affected by rising or falling stage in a 
stream, river, lake, or reservoir.  Impact areas are an optional element, and are only required 
when the user wants to compute impacts at damage area centers in the study area 
 
To import impact areas from a shapefile: 
 
 1. From the Maps menu (Figure 6.12), point to Import, click Impact Areas.  The Import 

Impact Areas dialog box will open (Figure 6.19).  The Shapefile Name list figures out 
whether there are any polygon shapefiles available in the maps directory; from the list the 
shapefile that represents the impact areas for the RussianRiver study - 
RR_ImpactAreas.shp. 
 

 
Figure 6.19  Import Impact Areas Dialog Box 
 

 2. From the Database Field Name list (Figure 6.19), the user needs to select the field name 
in the attribute file that contains the names of the impact areas - ID_Name.  Once a field 
name is selected, the table below will populate with the impact areas contained in the 
shapefile.  If there is an issue with any of the impact areas the checkbox in the Import 
column will not be selected. 

 
 3. Click Import, the Import Impact Areas dialog box will close (Figure 6.19).  Once the 

import of the impact areas is completed, a message window will appear letting the user 
know that the impact areas have been imported successfully.  In the active Map Window 
the impact areas appear as green polygons. 
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A user can also add impact areas to the schematic manually by performing the following steps: 
 
 1. From the Schematic Map Window, find the location where an impact area needs to be 

added, press the Impact Area Tool       . 
 
 2. Hold down the CTRL key while clicking the mouse button.  Each click creates a vertex 

point (Figure 6.20), which is the boundary of the polygon.  When reaching the end point, 
release the CTRL key and click. 

 

 
Figure 6.20  Draw an Impact Area 

 
 3. The Name New Impact Area dialog box will open (Figure 6.21).  Enter a name 

(Guerneville), and if needed, enter a description.  Click OK, the Name New Impact 
Area dialog box will close. 

 

 
Figure 6.21  Name New Impact Area Dialog Box 

 
 4. The impact area will now appear in the display area as a green polygon with a name. 
 
Following the steps in this chapter creates the basic schematic elements for an HEC-WAT 
watershed - stream alignment, common computation points, impact areas, and projects 
(reservoirs, levees). Now this basic schematic can be used by the models that are required for the 
watershed.  The user will have choices at this point - to either build the individual models in 
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HEC-WAT or build individual models outside of HEC-WAT.  If models are built outside of 
HEC-WAT, the user can import the individual models (Chapter 7) or if the models are the result 
of a Corps Water Management System (CWMS) watershed being available (Chapter 8). 
 
Either choice using the basic schematic built in HEC-WAT promotes collaboration with 
customers, partners and stakeholders involved in water resource studies. Users will be able to 
perform studies in an integrated and systems based approach. 
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Chapter 7  
 
 
 

Create an HEC-WAT Study from Existing 
Models 
 
 
If the HEC-WAT study the user is building has existing model files, the user can build an HEC-
WAT study from those models.  For the Russian River example, the user can create an HEC-
WAT study by importing individual model files (i.e., HEC-HMS, HEC-ResSim, HEC-RAS, 
HEC-FIA) that are available.   
 
7.1 Create an HEC-WAT Study 
 
To create a new study: 
 
 1. From the HEC-WAT main window (Figure 7.1), on the File menu, click New Study. The 

Create New Study dialog box (Figure 7.2) will open. 
 

 
Figure 7.1  HEC-WAT Main Window 

 
 2. In the Study Name box (Figure 7.2), enter a name (RussianRiver), and in the 

Description box, enter a description (Russian River water resources study) for the new 
study. 
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Figure 7.2  Create New Study Dialog Box 

 
 3. In the Directory box (Figure 7.1), either enter the name of the directory where the HEC-

WAT study will be stored, or click     , and an Open browser (Figure 7.3) will open.  
Navigate to the directory where the HEC-WAT study will be stored, click Open.  The 
Open browser (Figure 7.3) will close. On the Create New Study dialog box (Figure 7.2) 
in the Directory box the location will display. 

 

 
Figure 7.3  Open Browser 

 
 4. The Unit System (Figure 7.2) for the study defaults to English (which is correct for the 

RussianRiver study).  The other choice from the list is SI (metric). 
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 5. Next, the projected coordinate system of the study needs to be set.  From the Create New 
Study dialog box (Figure 7.2), click Edit (by the Coordinate System box), the Map 
Coordinate Information dialog box will open (Figure 7.4). 

 

 
Figure 7.4  Map Coordinate Information Dialog Box with Study Projection Information 

 
 6. For the RussianRiver study, the associated map layers have the correct projected 

coordinate system.  So, use one of those map layers to set the projected coordinate system 
for the study.  From the Map Coordinate Information dialog box (Figure 7.4), click 
Load from file (lower left corner of dialog box); an Open browser (Figure 7.3) will 
open. The map layers for the RussianRiver study are located in a folder titled 
RussianRiver_Data (double-click).  In that folder, is a MapLayers (double click) folder, 
from that folder, click on RR_StreamAlignment.prj (any of the map layers will work). 
Click Open, now the Map Coordinate Information dialog box will contain information 
about the projected coordinate system (Figure 7.4).  Click OK, the Map Coordinate 
Information dialog box will close (Figure 7.4).  Now on the Create New Study dialog 
box the Coordinate System box (Figure 7.2) contains the name of the projected 
coordinate system (i.e., USA_Continguous_Albers_Equal_Area_Conic_USGS_version) 
for the study. 

 
 7. Click OK; the Create New Study dialog box will close (Figure 7.2).  The HEC-WAT 

main window will now have the name of the study (RussianRiver) on the title bar (Figure 
7.5).  A blank Schematic Map Window opens. 
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Figure 7.5  HEC-WAT Main Window - RussianRiver Study 

 
7.2 Define Plug-Ins for a Study 
 
To define the plug-ins for the RussianRiver study: 
 
 1. From the HEC-WAT main window (Figure 7.5), from the File menu, click Study 

Details. 
 
 2. The Study Details dialog box (Figure 7.6) will open. Click on the Plug-ins tab. The table 

that is displayed provides information on the plug-ins that are available in for the study. 
 
 3. For the RussianRiver study the following plug-ins should be enabled – FIA, HEC-SSP, 

HMS, RAS, and, ResSim. 
 
 4. Click OK, the Study Details dialog box will close (Figure 7.6), and the plug-ins for the 

study have been defined. 
 
7.3 Import an HEC-ResSim Model 
 
If there is an HEC-ResSim model available, the user should import that model first.  Why? 
Because the HEC-ResSim model will contain a stream alignment, all of the common 
computation points (CCPs), and the reservoirs necessary to model the study area.   
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Figure 7.6  Study Details Dialog Box - Plugins Tab 

 
 1. From the HEC-WAT main window (Figure 7.5), from the File menu, point to Import, 

and click ResSim.  An Import Type window (Figure 7.7) will open, click Watershed. 
 

 
Figure 7.7  Import Type Window 

 
 2. The Select Watershed File to Import From (Figure 7.8) browser will open.  Browse to 

the folder RR_Models; double click on the base folder; double-click on the 
RR_ResSim_Model folder.  The Files of Type list should display ResSim Watershed 
Files; click RR_ResSim_Model.wksp; and, then click Open. 

 
 3. A ResSim Import window will open (Figure 7.9) showing the progress of the HEC-

ResSim import. 
 
 4. The HEC-WAT Schematic Editor will open (Figure 7.10), from the Measures area of 

the Schematic Editor, click Select All.  All of the reservoirs listed in the table are now 
selected. Click OK, the Schematic Editor will close (Figure 7.10). 



Chapter 7 - Create an HEC-WAT Study from Existing Models HEC-WAT Quick Start Guide 

7-6 

 
Figure 7.8  Select Watershed File to Import From Browser 

 
 

 
Figure 7.9  ResSim Import Window 

 
 5. The imported stream alignment, common computation points, reservoirs, and any 

available map layers from the HEC-ResSim model display in the HEC-WAT Schematic 
Map Window (Figure 7.11). For all of the map layers to appear, close the Schematic 
Map Window, from the message window click Yes.  To re-open the Schematic Map 
Window, from the Study Tree, double-click on Schematic: Without Project Conditions, 
the Schematic Map Window will appear in the Desktop Area of the HEC-WAT main 
window (Figure 7.11). 

 
 6. The user has now completed the import of the RussianRiver HEC-ResSim model. 
 
7.4 Import an HEC-HMS Model 
 
 1. From the HEC-WAT main window (Figure 7.5), from the File menu, point to Import, 

and click HMS.  The HEC-HMS application will open with the Select Project File 
browser already open (Figure 7.12).   
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Figure 7.10  Schematic Editor 

 
 

 
Figure 7.11  HEC-WAT Schematic Map Window After HEC-ResSim Import 
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Figure 7.12 HEC-HMS Main Window and Select Project File Browser 

 
 2. Browse to the folder RR_Models; double click on the RR_HMS_Model folder, select 

Russian_River.hms and, then click Select. 
 
 3. When the HEC-WAT study is created an hms subfolder is created.  In that subfolder are 

the default files that are generated when creating an HEC-HMS project.  When the HEC-
HMS import process finds that a project already exists, a warning window will appear 
(Figure 7.13).  Click Yes, the warning window will close. 

 

 
Figure 7.13 HEC-HMS Warning Window about HEC-HMS Project 

 
 4. The import process begins (patience this could take a few seconds), the import is finished 

when the study pane in the HEC-HMS main window contains a study tree. From the 
HEC-HMS main window (Figure 7.12), from the File menu, click Exit. 

 
 5. The user has now completed the import of the RussianRiver HEC-HMS model. 
 
7.5 Import an HEC-RAS Model 
 
 1. From the HEC-WAT main window (Figure 7.5), from the File menu, point to Import, 

and click RAS.  The Select RAS project to import from browser will open (Figure 
7.14).   
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7.14  Select RAS project to import from Browser 

 
 2. Browse to the folder RR_Models; double click on the RR_RAS_Model folder, select 

RussianRiver.prj and, then click Open. 
 
 3. The Select RAS project to import from browser will close (Figure 7.15). An Importing 

window (Figure 7.15) will open; when the HEC-RAS model import is complete this 
window will close.   

 

 
Figure 7.15  HEC-RAS Importing Window 

 
 4. The user has now completed the import of the RussianRiver HEC-RAS model. 
 
7.6 Import an HEC-FIA Model 
 
 1. From the HEC-WAT main window (Figure 7.5), from the File menu, point to Import, 

and click FIA.  The Import Alternatives dialog box will open (Figure 7.16).   
 

 
Figure 7.16  Import Alternatives Dialog Box 
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 2. Click Select/Add Project, an Open browser will open (Figure 7.3).  Browse to the folder 
RR_Models; double click on the RR_FIA_Model folder, select Russian_River.prj and, 
then click Open. 

 
 3. The table will now contain the name of the Project (RussianRiver).  From the 

Alternative column (Figure 7.17), from the list, select the HEC-FIA alternative that will 
be imported (GridsAndXSecsAlternative). 

 

 
Figure 7.17  HEC-FIA Import Alternative Table 

 
 4. Click Edit Alternative Specifications, the Alternative Specification dialog box will 

open.  Select Copy Projection from project, and click OK. 
 
 5. Click Import Alternatives, in the Progress column of the table (Figure 7.17) the cell 

will display the progress of the import with a green bar.  When the import is complete an 
Information window will open, click OK. 

 
 6. From the Import Alternatives dialog box (Figure 7.17) click Close.  A RussianRiver 

HEC-FIA model alternative has been imported. 
 
7.7 Add Map Layers 
 
Now that the base models are in the watershed lets add some map layers: 
 
 1. From the HEC-WAT main window (Figure 7.5), from the Maps menu, click Add Map 

Layers, the Select Map to Add browser will open (Figure 7.18).  Click Create Copy.  
Browse to the folder RussianRiver_Data; double click on the MapLayers folder, select 
the following map layers: 

 

 
Figure 7.18  Select Map to Add Browser 
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 ● Find the map layer which represents the impact areas - RR_ImpactAreas.shp 
 ● Find the map layer which represents the CCPs - RR_CommonComputationPoints.shp 
 
 2. Click Open, the Select Map to Add browser will close (Figure 7.18).  The HEC-WAT 

Schematic Map Window (Figure 7.19) will now display the added map layers. 
 
 3. The user can now make 

adjustments to the map layers.  
From the HEC-WAT main 
window (Figure 7.5), click the 
Maps tab.  From the Map 
Layers tree: 

 
 ● Right-click on the 

Stream Alignment layer, 
from the shortcut menu, 
click Move to Top.  

 
 ● Right-click on the 

Without Project 
Conditions layer, from 
the shortcut menu, click 
Move to Top. 

 
 ● Un-check the 

Raingages_Albers_ft.shp 
map layer (this will cause 
the map layer to no 
longer display in the 
active map window). 

 
 ● Right-click on the 

RR_ImpactAreas.shp 
map layer, from the 
shortcut menu, click 
Properties.  The Edit 
Polygon Properties 
Editor will open (Figure 
7.20).  From the Fill tab, 
change the color to 
"lightgreen", click OK.  
The impact areas on the 
active map window will now display in "lightgreen". 

 
 4. The user can adjust the view of the study area in the active map window.  Using the 

Magnifier Tool, zoom the study area in the active map window to the appropriate area 
that the user would like displayed.  From the HEC-WAT main window (Figure 7.5), from 
the Maps menu, click Default Map Properties, the Default Map Properties for dialog  

Figure 7.19  Map Layers Added to Watershed 
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Figure 7.20  Edit Polygon Properties Editor 

 
  box will open (Figure 7.21).  Click Set Map Extents to Display, click OK.  The Default 

Map Properties for dialog box will close. 
 

 
Figure 7.21  Default Map Properties for Dialog Box 

 
This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 

 
7.8 Create an Analysis Period 
 
An HEC-WAT compute requires an HEC-WAT alternative, an analysis period, a program order, 
and model alternatives.   
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To create an analysis period: 
 
 1. From the HEC-WAT main window (Figure 7.5), from the Study Tree, right-click on the 

Analysis Periods folder (Figure 7.22).  From the shortcut menu click New. 
 

 
Figure 7.22  Analysis Period Shortcut Menu 

 
 2. The Create New Analysis Periods dialog box will open (Figure 7.23).  In the Name box 

enter a name (RR_Feb1986).  In the Time Window box enter the information required 
for the time window. 

 

 
Figure 7.23  Create New Analysis Periods Dialog Box 

 
 3. For the Start Date and End Date, enter in the format ddmmmyyyy.  The Start Time and 

End Time should be entered as military time - e.g. 0000, 0600, 1300 (1 p.m.), 2400 
(midnight). 

 
 4. Click OK, the Create New Analysis Periods dialog box will close (Figure 7.23).  On the 

HEC-WAT main window (Figure 7.6), from the Study Pane, under the Analysis Periods 
folder, the new analysis period name will appear. 

 
7.9 Setup Lookback Window – HEC-ResSim 
 
The time window for an HEC-ResSim simulation has two parts, a "lookback period" and a 
"simulation or forecast period".  The lookback period is used by HEC-ResSim to "warm up" a 
HEC-ResSim model alternative.  During this period, routing of flows through the river and 
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reservoir network are performed but no release decisions are made nor are any mass balance 
computations evaluated.  The user should think of the lookback period as the time to establish 
the state of the river network and the starting conditions of the reservoirs.  The simulation period 
is the portion of the time window during which HEC-ResSim simulates reservoir operations, and 
makes release decisions based on the operation scheme defined by the user.  Releases are then 
routed through the river network, combining with local inflows along the way.   
 
Since HEC-WAT and most of the models treat the analysis period as a single, continuous time 
window, a setup step is required for each HEC-ResSim alternative in an HEC-WAT study.  The 
setup step lets each HEC-ResSim model alternative know how much of the analysis period to use 
for the lookback period.   
 
To setup the lookback period: 
 
 1. From the HEC-WAT main window (Figure 7.5), from the Edit menu, point to ResSim, 

click Lookback Window (Figure 7.24). 
 

 
Figure 7.24  Edit Menu – ResSim – Lookback Window 

 
 2. The Lookback Window dialog box (Figure 7.25) will open. 
 

 
Figure 7.25  Lookback Window Dialog Box 

 



HEC-WAT Quick Start Guide Chapter 7 - Create an HEC-WAT Study from Existing Models 

 7-15 

 3. The table displays the HEC-ResSim alternatives that are available in the HEC-WAT 
study.  Each alternative that is being used in an HEC-WAT simulation will need to have a 
lookback window set.  For example, in Figure 7.25, the HEC-ResSim alternative 
calibrate has a TimeStep of 1 hour and Lookback Steps of 6. 

 
 4. The time step can be selected from the TimeStep column, in each cell there is a list of 

available time steps for the user to choose from.  The selected time step has to match the 
time step that was specified for the HEC-ResSim alternative as part of the alternative's 
original run control data (which is located in the HEC-ResSim Alternative Editor). The 
number of lookback steps must be entered in a cell in the Lookback Steps column. At 
least one lookback time step is required for a HEC-ResSim alternative to compute, 
however more lookback steps may be needed, depending on a variety of factors in the 
HEC-ResSim alternative's operating scheme.  The HEC-ResSim modeler should be 
consulted to determine the minimum lookback window needed by each alternative. 

 
 5. Click OK, a Missing Lookback Info window (Figure 7.26) will open.  This message 

window is letting the user know that lookback information for the other HEC-ResSim 
alternatives have not been set.  For this example, the user is only using the calibrate 
alternative, click OK.  The Missing Lookback Info window (Figure 7.26) and the 
Lookback Window dialog box (Figure 7.25) will both close. 

 

 
Figure 7.26  Missing Lookback Info Window 

 
7.10 Program Order 
 
HEC-WAT allows for a flexible set of programs, computation order, and data flow through the 
establishment of a program order.  Once a program order has been chosen for an HEC-WAT 
study, changes should not be made to the program order as this could cause a disruption in the 
flow of data and invalidate any existing work. 
 
Currently in HEC-WAT Version 1.0 the default program order is - HMS, ResSim, RAS, FIA.  
This is the correct program order for the example watershed that is being used, so no adjustment 
is necessary.  For further details on Program Order, review Chapter 11 (Section 11.1) of the 
HEC-WAT User's Manual. 
 
7.11 Create an HEC-WAT Simulation 
 
Now that all of the building blocks have been configured (alternative, analysis period, program 
order, models), the user can now create an HEC-WAT simulation.  To create an HEC-WAT 
simulation: 
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 1. From the HEC-WAT main window (Figure 7.5), from the WAT Tools toolbar, click the 
Alternative and Simulation Manager button       . 

 
 2. The Alternative and Simulation Manager will open (Figure 7.27).  From this dialog 

box the user can create/modify alternatives, analysis periods, simulations, program 
orders, link models, and make runs. 

 

 
Figure 7.27  Alternative and Simulation Manager 

 
 3. To create a simulation, from the table right-click on the intersection of an alternative and 

analysis period.  From the shortcut menu click Create Simulation.  The Create New 
Simulation dialog box will open (Figure 7.28). 

 

 
Figure 7.28  Create New Simulation Dialog Box 
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 4. HEC-WAT has defined a default name for the simulation (Without Project Conditions-
RR_Feb1986) in the Name box (Figure 7.28).  The name is a combination of the HEC-
WAT alternative name and analysis period name, where the intersection was in the table 
(name can be changed).  Also, in the Alternative and Analysis Period lists (Figure 7.28) 
the selections have already been made based on the intersection in the table.  The selected 
Alternative cannot be changed, but the selected Analysis Period can be changed. 

 
 5. The program order is Default. 
 
 6. In the F Part box (Figure 7.28), a default F Part is displayed that was generated by 

HEC-WAT based once again on the alternative and analysis period names. The user can 
edit the item, but it is not advised. 

 
 7. In the Programs table (Figure 7.28), the software applications that were defined in the 

program order appear in the order they were selected.  Now the user must select the 
appropriate model alternatives (plan, run) for each software application. From the 
Alternative column, from the list for HMS (Figure 7.29), select the appropriate HMS 
model alternative ((RUN)Feb_1986).  Repeat the process for the other software 
applications. Below is the list of the appropriate model alternatives for the RussianRiver 
study: 

 
 HMS - (RUN)Feb_1986 
 ResSim - calibrate 
 RAS - Base for Real Time forecasting 
 FIA – GridsAndXSecsAlternative 
 

 
Figure 7.29  Selection of Model Alternatives - Create New Simulation Dialog Box 

 
 8. Now that all of the model alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 7.29).  On the Alternative and Simulation 
Manager (Figure 7.30), the intersection of an HEC-WAT alternative and analysis period 
now provides information about the simulation. 

 
 9. Click OK; the Alternative and Simulation Manager will close (Figure 7.30).  From the 

HEC-WAT main window (Figure 7.5), the created simulation appears on the Study Tree, 
under the Simulations folder (Figure 7.31). 

 
 10. The Content Pane (Figure 7.32) displays information about the selected simulation. 
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Figure 7.30  Alternative and Simulation Manager - Completed Simulation 

 

 
Figure 7.31  Study Tree with Created Simulation 

 

 
Figure 7.32  Content Pane 

 
 11. Double click on the simulation name (Without Project Conditions-RR_Feb1986), a Select 

Map dialog box will open. Click New Map Window, click OK. The Select Map dialog 
box will close.  The new map window will contain the schematic elements that represent 
the simulation (Figure 7.33). 
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Figure 7.33  Map Window - Schematic of Current HEC-WAT Simulation 
 
7.12 Linking 
 
The next step is to have the models of a simulation communicate with each other.  This is 
accomplished by linking (DSS mapping) the models thru DSS and using a simulation name.  
From HEC-WAT, the Model Linking Editor (Figure 7.34) provides an easy way to link models 
including observed data, and provides a mechanism where the linking will have to be done once 
per alternative. 
 

 
Figure 7.34  Model Linking Editor 
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 1. From the HEC-WAT main window (Figure 7.33), from the WAT Tools toolbar, click the 
Model Linking Editor button        . 

 
 2. The Model Linking Editor will open (Figure 7.34).  From the Simulation list the user 

will need to select a simulation.  For this example the user will be selecting the Without 
Project Conditions-RR_Feb1986 (default) simulation. 

 
 3. Now let's link the individual model alternatives that are part of the selected simulation. 
 
7.12.1 Linking the HMS Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select HMS-

(RUN)FEB_1986 (Figure 7.34).  The Model Linking Editor table (Figure 7.35) will now 
contain all of the locations for the HMS model alternative. 

 

 
Figure 7.35  Model Linking Editor – HMS Model Alternative 

 
 2. Since HEC-HMS wants precipitation and flow data that is not provided by another 

software application, HEC-WAT reads the linking from the HMS model alternative and 
displays that linking in the Model Linking Editor table (Figure 7.35). 

 
 3. The table displays the linking from a DSS file for the HMS model alternative which is the 

correct linking. 
 
7.12.2 Linking the ResSim Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select ResSim-calibrate 

(Figure 7.35).  The Model Linking Editor table (Figure 7.36) will now contain all of the 
locations for the ResSim model alternative that need to be linked.   
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Figure 7.36  Model Linking Editor – ResSim Model Alternative 

 
 2. The current linking (Figure 7.37) that is displayed for the ResSim model alternative is 

correct, so the linking does not need to be done. 
 
7.12.3 Linking the RAS Model Alternative 
 
 1. From the Modeling Linking Editor, from the Model to Link list select RAS-Base for 

Real Time forecasting (Figure 7.36).  The Model Linking Editor table (Figure 7.37) 
contains all of the locations for the RAS model alternative that need to be linked.  The 
current linking (Figure 7.37) that is displayed is the HEC-RAS linking for the standalone 
model. 

 

 
Figure 7.37  Model Linking Editor - RAS Model Alternative Unlinked 
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 2. RAS model alternative linking will be the results from the HMS and ResSim model 
alternatives.  

 
 3. From the Model Linking Editor (Figure 7.37), click Default Model to Link.  The 

Select Default Model to Link dialog box will open (Figure 7.38).  From the Default 
Model to Link list, select HMS-(RUN)Feb_1986.  Click OK, the Select Default Model 
to Link dialog box will close (Figure 7.38). 

 

 
Figure 7.38  Select Default Model to Link Dialog Box 

 
 4. A Confirm Input from the "Input From Model" changing to window (Figure 7.39) 

will appear. Basically the window is asking the user to be sure before proceeding, click 
Yes. The Confirm Input from the "Input From Model" changing to window closes, 
and the Model Linking Editor now displays the linking for the RAS model alternative 
(Figure 7.40). 

 

 
Figure 7.39  Confirm Input from Model changing to Window 

 

 
Figure 7.40 Model Linking Editor - RAS Model Alternative Linking to an HMS Model 

Alternative 
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 5. There are two locations in the RAS linking that need to be linked to the ResSim model 
alternative.  From the Model Linking Editor table (Figure 7.40) for the DryCreek 
DryCreek RS 74716.8 (Sonoma Outflow J) row, from the Input Model column (Figure 
7.40), select ResSim-calibrate. HEC-WAT tries to find a match, Lake Sonoma-Pool - 
Outflow.  From the Location/Parameter column list, select Lake Sonoma Outflow JCT - 
Flow. 

 
 6. Repeat Step 5 for the Russian CoyoteToDC RS 527387.7 (Lake Mendocino O) row (Lake 

Mendocino-Pool - Outflow) from the Location/Parameter column list, select Lake 
Mendocino Outflow JCT - Flow. 

 
 7. Refer to the printout (RussianRiverLinking.pdf; located in a folder titled 

RussianRiver_Data) for the linking for each of the model alternatives.  Once the linking 
is finished for the RAS model alternative, from the Model Linking Editor (Figure 7.41) 
click      , this will save the linking. 

 

 
Figure 7.41  Model Linking Editor - Completed RAS Model Alternative Linking 

 
 8. That completes the linking for the RAS model alternative. 
 
7.12.4 Linking the FIA Model Alternative 
 
 1. From the Model Lining Editor, from the Model to Link list select FIA-

GridsAndXSecsAlternative (Figure 7.41).  The Model Linking Editor table (Figure 7.42) 
will now contain all of the locations for the FIA model alternative that need to be linked. 

 
 2. For the FIA model alternative, the linking will be results from the RAS model alternative.  
 
 3. From the Model Linking Editor (Figure 7.42), click Default Model to Link.  The 

Select Default Model to Link dialog box will open (Figure 7.38).  From the Default  
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Figure 7.42  Model Linking Editor - FIA Model Alternative Unlinked 

 
  Model to Link list, select RAS-Base for Real Time forecasting.  Click OK, the Select 

Default Model to Link dialog box will close (Figure 7.38). 
 
 4. A Confirm Input from the "Input From Model" changing to window (Figure 7.39) 

will appear. Basically the window is asking the user to be sure before proceeding, click 
Yes. The Confirm Input from the "Input From Model" changing to window closes, 
and the Model Linking Editor now displays the linking for the RAS model alternative 
(Figure 7.43). 

 

 
Figure 7.43  Model Linking Editor - FIA Model Alternative Linking to RAS Model Alternative 
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 5. The user will need to adjust two rows for the FIA linking; HEC-WAT did not choose the 
correct locations. In Figure 7.43, for the first row (DryCreek DryCreek 74716.8), change 
the Location/Parameter column to DryCreek Dry Creek 74716.8 (Sonoma Outflow J) - 
Stage.  Repeat for the row Russian CoyoteToDC 527387.7 and change the 
Location/Parameter column to Russian CoyoteToDC 527387.7 (Lake Mendocino O) - 
Stage. 

 
 6. Refer to the printout (RussianRiverLinking.pdf; located in a folder titled 

RussianRiver_Data) for the linking for each of the model alternatives.  Once the linking 
is finished for the RAS model alternative, from the Model Linking Editor (Figure 7.44) 
click      , this will save the linking. 

 
 7. That completes the linking for the FIA model alternative. 
 

 
Figure 7.44  Model Linking Editor – Completed FIA Model Alternative Linking 

 
7.13 Compute and Results 
 
Now that a simulation has been defined, the linking of model alternatives has been completed for 
the simulations, and model alternatives have been imported into HEC-WAT, the user is now 
ready to compute the Russian River watershed. 
 
 1. From the HEC-WAT main window (Figure 7.45), from the Study Tree, from the 

Simulations folder, right-click Without Project Conditions-RR_Feb1986. From the 
shortcut menu (Figure 7.45) point to Compute, hold down the Ctrl key, click 
Simulation. 

 
 2. The Compute Progress dialog box will open (Figure 7.46).  The compute for the 

Russian River study takes about 20 minutes. 
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Figure 7.45  HEC-WAT Main Window - Compute 

 
 3. When the compute is finished, click Close, the Compute Progress dialog box will close 

(Figure 7.46). 
 

 
Figure 7.46  Compute Progress Dialog Box 
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Chapter 8  
 
 
 

Create an HEC-WAT Study from a CWMS 
Watershed 
 
 
If the HEC-WAT study the user is building already has been built in the Corps Water 
Management System (CWMS) software, an HEC-WAT study can be created from the CWMS 
watershed.  For the Russian River example, the user can create an HEC-WAT study by importing 
the available CWMS watershed.   
 
8.1 Create an HEC-WAT Study 
 
To create a new study: 
 
 1. From the HEC-WAT main window (Figure 8.1), on the File menu, click New Study. The 

Create New Study dialog box (Figure 8.2) will open. 
 

 
Figure 8.1  HEC-WAT Main Window 

 
 2. In the Study Name box (Figure 8.2), enter a name (RussianRiver), and in the 

Description box, enter a description (Russian River water resources study) for the new 
study. 
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Figure 8.2  Create New Study Dialog Box 

 
 3. In the Directory box (Figure 8.1), either enter the name of the directory where the HEC-

WAT study will be stored, or click     , and an Open browser (Figure 8.3) will open.  
Navigate to the directory where the HEC-WAT study will be stored, click Open.  The 
Open browser (Figure 8.3) will close. On the Create New Study dialog box (Figure 8.2) 
in the Directory box the location will display. 

 

 
Figure 8.3  Open Browser 
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 4. The Unit System (Figure 8.2) for the study defaults to English (which is correct for the 
RussianRiver study).  The other choice from the list is SI (metric). 

 
 5. Next, the projected coordinate system of the study needs to be set.  From the Create New 

Study dialog Box (Figure 8.2), click Edit (by the Coordinate System box), the Map 
Coordinate Information dialog box will open (Figure 8.4). 

 

 
Figure 8.4  Map Coordinate Information Dialog Box with Study Projection Information 

 
 6. For the RussianRiver study, the associated map layers have the correct projected 

coordinate system.  So, use one of those map layers to set the projected coordinate system 
for the study.  From the Map Coordinate Information dialog box (Figure 8.4), click 
Load from file (lower left corner of dialog box); an Open browser (Figure 8.3) will 
open. The map layers for the RussianRiver study are located in a folder titled 
RussianRiver_Data (double-click).  In that folder, is a MapLayers (double-click) folder, 
from that folder, click on RR_StreamAlignment.prj (any of the map layers will work). 
Click Open, now the Map Coordinate Information dialog box will contain information 
about the projected coordinate system (Figure 8.4).  Click OK, the Map Coordinate 
Information dialog box will close (Figure 8.4).  Now on the Create New Study dialog 
box the Coordinate System box (Figure 8.2) contains the name of the projected 
coordinate system (i.e., USA_Continguous_Albers_Equal_Area_Conic_USGS _version) 
for the study. 

 
 7. Click OK; the Create New Study dialog box will close (Figure 8.1).  The HEC-WAT 

main window will now have the name of the study (RussianRiver) on the title bar (Figure 
8.5).  A blank Schematic Map Window opens. 
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Figure 8.5  HEC-WAT Main Window - RussianRiver Study 

 
8.2 Import a CWMS Watershed 
 
To import a CWMS watershed: 
 
 1. From the File menu, point to Import, click CWMS Watershed.  The Import CWMS 

Watershed dialog box will open (Figure 8.6). 
 

 
Figure 8.6  Import CWMS Watershed Dialog Box 
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 2. Now select the RussianRiver CWMS watershed file.  From the CWMS Watershed File 
box, click     , and the Select Workspace File browser (Figure 8.7) will open.  Browse to 
the directory (C \Desktop\RussianRiver_Data\CWMS_Watershed/RussianRiver) and 
select RussianRiver.wtrshd. Click Import, the Select Workspace File browser will close 
(Figure 8.7). 

 

 
Figure 8.7  Select Workspace File Browser 

 
 3. A Continue Import? window will open (Figure 8.8).  This window is warning the user 

that the import process will overwrite any existing data in the watershed.  Click Yes, the 
Continue Import? window will close (Figure 8.8) 

 

 
Figure 8.8  Continue Import? Window 

 
 4. The Import CWMS Watershed dialog box (Figure 8.9) will now display the name of 

the CWMS watershed file in the CWMS Watershed File box (Figure 8.9).  As the 
import proceeds, the Import Progress box on the Import CWMS Watershed dialog 
box (Figure 8.9) will display what is happening during the import.  The table on the 
Import CWMS Watershed dialog box (Figure 8.9) will display which CWMS 
watershed components have finished, whether the import was successful or not, and the 
number of model alternatives that were imported. 
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Figure 8.9  Importing RussianRiver CWMS Watershed 

 
 5. When the HEC-WAT study is created an hms subfolder is created.  In that subfolder are 

the default files that are generated when creating an HEC-HMS project.  When the HEC-
HMS import process finds that a project already exists, a warning window will appear 
(Figure 8.10; this warning window can open behind the HEC-WAT main window).  
Click Yes, the warning window will close. 

 

 
Figure 8.10  HEC-HMS Warning Window about HEC-HMS Project 

 
 6. If the HEC-HMS model was created using Version 4.0/4.1, a Convert HEC-HMS 

Project window (Figure 8.11) will open.  This window is letting the user know that the 
HEC-HMS model will be converted to a Version 4.2 HEC-HMS model. Click Convert 
Project, the Convert HEC-HMS Project window (Figure 8.11) will close, and the 
import of the watershed will continue. 

 

 
Figure 8.11  Convert HEC-HMS Project Window 
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 7. Once the import process is finished from the Import CWMS Watershed dialog box 

(Figure 8.9) click Close.  The Import CWMS Watershed dialog box (Figure 8.9) will 
close, and the HEC-WAT main window (Figure 8.12) will display the map layers and the 
stream alignment of the imported CWMS watershed. 

 

 
Figure 8.12  HEC-WAT Main Window - RussianRiver Study - Map Layers & Stream Alignment 

 
 7. From the File menu, click Save Study. 
 
8.3 Adjust Schematic - Reservoir Displays 
 
The reservoir elements from the HEC-ResSim model, do not automatically display on the HEC-
WAT Schematic Map Window.  From the Study Pane, from the Study Tree under the 
Simulations folder, right-click on Schematic:Without Project Conditions.  From the shortcut 
men, click Edit.  The Schematic Editor (Figure 8.13) will open, under Measures, click Select 
All.  Click OK, the Schematic Editor will close, and the HEC-ResSim reservoir elements will 
appear on the HEC-WAT Schematic Map Window. 
 
8.4 Adjust Map Layers 
 
Part of the CWMS import, includes importing map layers for the HEC-WAT study.  Now the 
user can make adjustments to the map layers. 
 
 1. From the HEC-WAT main window, click the Maps tab (Figure 8.12).  Now the user can 

see which Map Window is currently active and what layers make up that Map Window.  
The user can now make adjustments to the map layers, from the Map Layers tree: 
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Figure 8.13  Schematic Editor 

 
 ● Un-check the Raingages_Albers_ft.shp map layer (this will cause the map layer to 

no longer display in the active map window). 
 
 ● Right-click on the RR_ImpactAreas.shp map layer, from the shortcut menu, click 

Properties.  The Edit Polygon Properties Editor will open (Figure 8.14).  From 
the Fill Tab, change the color to "lightgreen", click OK.  The impact areas on the 
active map window will now display in "lightgreen". 

 

 
Figure 8.14  Edit Polygon Properties Editor 

 
 2. The user can adjust the view of the study area in the active map window.  Using the 

Magnifier Tool, zoom the study area in the active map window to the appropriate area 
that the user would like displayed.  From the HEC-WAT main window (Figure 8.12), 
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from the Maps menu, click Default Map Properties, the Default Map Properties for 
dialog box will open (Figure 8.15).  Click Set Map Extents to Display, click OK.  The 
Default Map Properties for dialog box will close. 

 

 
Figure 8.15  Default Map Properties for Dialog Box 

 
This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 

 
8.5 Define Plug-Ins for Study 
 
To define the plug-ins for the RussianRiver study: 
 
 1. From the HEC-WAT main window (Figure 8.12), from the File menu, click Study 

Details. 
 
 2. The Study Details dialog box (Figure 8.16) will open. Click on the Plug-ins tab. The 

table that is displayed provides information on the plug-ins that are available for the 
study. 

 
 3. For the RussianRiver study the following plug-ins should be enabled – FIA, HEC-SSP, 

HMS, RAS, and, ResSim. 
 
 4. Click OK, the Study Details dialog box will close (Figure 8.16), and the plug-ins for the 

study have been defined 
 
8.6 Create an Analysis Period 
 
An HEC-WAT compute requires an HEC-WAT alternative, an analysis period, a program order, 
and model alternatives. 
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Figure 8.16  HEC-WAT – Study Details Dialog Box - Plugins Tab 

 
To create an analysis period: 
 
 1. From the HEC-WAT main window (Figure 8.12), from the Study Tree, right-click on 

the Analysis Period folder (Figure 8.17).  From the shortcut menu click New.  
 

 
Figure 8.17  Analysis Periods Shortcut Menu 

 
 2. The Create New Analysis Periods dialog box will open (Figure 8.18).  In the Name box 

enter a name (RR_Feb1986).  In the Time Window box enter the information required 
for the time window. 

 
 3. For the Start Date and End Date, enter in the format ddmmmyyyy.  The Start Time and 

End Time should be entered as military time - e.g. 0000, 0600, 1300 (1 p.m.), 2400 
(midnight). 
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Figure 8.18  Create New Analysis Periods Dialog Box 

 
 4. Click OK, the Create New Analysis Periods dialog box will close (Figure 8.18).  On the 

HEC-WAT main window (Figure 8.12), from the Study Pane, under the Analysis 
Periods folder, the new analysis period name will appear. 

 
8.7 Setup Lookback Window – HEC-ResSim 
 
The time window for an HEC-ResSim run has two parts, a "lookback period" and a "simulation 
or forecast period".  The lookback period is used by HEC-ResSim to "warm up" a ResSim model 
alternative.  During this period, routing of flows through the river and reservoir network are 
performed but no release decisions are made nor are any mass balance computations evaluated.  
The user should think of the lookback period as the time to establish the state of the river 
network and the starting conditions of the reservoirs.  The simulation period is the portion of the 
time window during which HEC-ResSim simulates reservoir operations, and makes release 
decisions based on the operation scheme defined by the user.  Releases are then routed through 
the river network, combining with local inflows along the way.   
 
Since HEC-WAT and most of the models treat the analysis period as a single, continuous time 
window. For this reason a setup step is required for each HEC-ResSim alternative in an HEC-
WAT study.  The setup step lets each HEC-ResSim alternative know how much of the analysis 
period to use for the lookback period.   
 
To setup the lookback period: 
 
 1. From the HEC-WAT main window (Figure 8.12), from the Edit menu, point to ResSim, 

click Lookback Window (Figure 8.19). 
 
 2. The Lookback Window dialog box (Figure 8.20) will open. 
 
 3. The table displays the ResSim model alternatives that are available in the HEC-WAT 

study.  Each model alternative that is being used in an HEC-WAT simulation will need to 
have a lookback window set.   For example, in Figure 8.20, the ResSim model alternative 
calibrate has a TimeStep of 1 hour and Lookback Steps of 6. 
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Figure 8.19  Edit Menu – ResSim – Lookback Window 

 

 
Figure 8.20  Lookback Window Dialog Box 

 
 4. The time step can be selected from the TimeStep column, in each cell there is a list of 

available time steps for the user to choose from.  The selected time step has to match the 
time step that was specified for the ResSim model alternative as part of the alternative's 
original run control data (which is located in the HEC-ResSim Alternative Editor). The 
number of lookback steps must be entered in a cell in the Lookback Steps column. At 
least one lookback time step is required for a ResSim model alternative to compute, 
however more lookback steps may be needed, depending on a variety of factors in the 
ResSim model alternative's operating scheme.  The HEC-ResSim modeler should be 
consulted to determine the minimum lookback window needed by each alternative. 

 
 5. Click OK, a Missing Lookback Info window (Figure 8.21) will open.  This message 

window is letting the user know that lookback information for the other ResSim model 
alternatives have not been set.  For this example, the user is only using the calibrate 
model alternative, click OK.  The Missing Lookback Info window (Figure 8.21) and the 
Lookback Window dialog box (Figure 8.20) will both close. 
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Figure 8.21  Missing Lookback Info Window 

 
8.8 Program Order 
 
HEC-WAT allows for a flexible set of programs, computation order, and data flow through the 
establishment of a program order.  Once a program order has been chosen for an HEC-WAT 
study, changes should not be made to the program order as this could cause a disruption in the 
flow of data and invalidate any existing work. 
 
Currently in HEC-WAT Version 1.0 the default program order is - HMS, ResSim, RAS, FIA.  
This is the correct program order for the example watershed that is being used, so no adjustment 
is necessary.  For further details on Program Order, review Chapter 11 (Section 11.1) of the 
HEC-WAT User's Manual. 
 
8.9 Create an HEC-WAT Simulation 
 
Now that all of the building blocks have been configured (alternative, analysis period, program 
order, models), the user can now create an HEC-WAT simulation.  To create an HEC-WAT 
simulation: 
 
 1. From the HEC-WAT main window (Figure 8.12), from the WAT Tools toolbar, click the 

Alternative and Simulation Manager button      . 
 
 2. The Alternative and Simulation Manager dialog box will open (Figure 8.22).  From 

this dialog box the user can create/modify alternatives, analysis periods, simulations, 
program orders, link models, and make runs. 

 

 
Figure 8.22  Alternative and Simulation Manager Dialog Box 
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 3. To create a simulation, from the table right-click on the intersection of an alternative and 
analysis period.  From the shortcut menu click Create Simulation.  The Create New 
Simulation dialog box will open (Figure 8.23). 
 

 
Figure 8.23  Create New Simulation Dialog Box 

 
 4. HEC-WAT has defined a default name for the simulation (Without Project Conditions-

RR_Feb1986) in the Name box (Figure 8.23).  The name is a combination of the HEC-
WAT alternative name and analysis period name, where the intersection was in the table 
(name can be changed).   

 
 5. A program order needs to be selected.  From the Program Order list (Figure 8.23) make 

sure Default is selected as the program order. 
 
 6. In the F Part box (Figure 8.23), a default F Part is displayed that was generated by 

HEC-WAT based once again on the alternative and analysis period names. The user can 
edit the item, but it is not advised. 

 
 7. In the Programs table (Figure 8.23), the software applications that were defined in the 

program order appear in the order the software applications were selected.  Now the user 
must select the appropriate alternative (plan, run) for each software application. From the 
Alternative column, from the list for HMS (Figure 8.24), select the appropriate HMS run 
((RUN)Feb_1986).  Repeat the process for the other software applications. Below is the 
list of the appropriate alternatives for the RussianRiver study: 

 
 HMS - (RUN)Feb_1986 
 ResSim - calibrate 
 RAS - Base for Real Time forecasting 
 FIA - GridsAndXSecsAlternative 
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Figure 8.24  Selection of Model Alternatives - Create New Simulation Dialog Box 

 
 8. Now that all of the model alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 8.23).  On the Alternative and Simulation 
Manager (Figure 8.25) dialog box, the intersection of the WAT alternative and analysis 
period now provides information about the simulation. 

 

 
Figure 8.25  Alternative and Simulation Manager - Completed Simulation 

 
 9. Click OK; the Alternative and Simulation Manager dialog box will close (Figure 

8.25).  From the HEC-WAT main window (Figure 8.12), the created simulation appears 
on the Study Tree, under the Simulations folder (Figure 8.26), click on the simulation. 

 

 
Figure 8.26  Study Tree with Created Simulation 
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 10. The Content Pane (Figure 8.27) displays information about the selected simulation. 
 

 
Figure 8.27  Content Pane 

 
 11. Double click on the simulation name (Without Project Conditions-RR_Feb1986), a Select 

Map dialog box will open. Click New Map Window, click OK. The Select Map dialog 
box will close.  The new map window will contain the schematic elements that represent 
the simulation (Figure 8.28). 

 

 
Figure 8.28  Map Window - Schematic of Current HEC-WAT Simulation 

 
8.10 Linking 
 
The next step is to have the models of a simulation communicate with each other.  This is 
accomplished by linking (DSS mapping) the models thru DSS and using a simulation name.  
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From HEC-WAT, the Model Linking Editor (Figure 8.29) provides an easy way to link models 
including observed data, and provides a mechanism where the linking will have to be done once 
per alternative. 
 

 
Figure 8.29  Model Linking Editor 
 
 1. From the HEC-WAT main window (Figure 8.28), from the WAT Tools toolbar, click the 

Model Linking Editor button        . 
 
 2. The Model Linking Editor will open (Figure 8.29).  From the Simulation list the user 

will need to select a simulation.  For this example the user will be selecting the Without 
Project Conditions-RR_Feb1986 (default) simulation. 

 
 3. Now let's link the individual model alternatives that are part of the selected simulation. 
 
8.10.1 Linking the HMS Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select HMS-(RUN)FEB 
  _1986 (Figure 8.29).  The Model Linking Editor table (Figure 8.30) will now contain all 

of the locations for the HMS model alternative. 
 
 2. Since HEC-HMS wants precipitation and flow data that is not provided by another 

software application, HEC-WAT reads the linking from the HMS model alternative and 
displays that linking in the Model Linking Editor table (Figure 8.30). 

 
 3. The table displays the linking from a DSS file for the HMS model alternative which is the 

correct linking. 
 
 4. That completes the linking for the HMS model alternative. 
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Figure 8.30  Model Linking Editor – HMS Model Alternative 

 
8.10.2 Linking the ResSim Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select ResSim-calibrate 

(Figure 8.30).  The Model Linking Editor table (Figure 8.31) will now contain all of the 
locations for the ResSim model alternative that needs to be linked.   

 

 
Figure 8.31  Model Linking Editor – ResSim Model Alternative 

 
 2. The current linking (Figure 8.31) that is displayed for the ResSim model alternative is 

correct, so the linking for the ResSim model alternative does not need to be done. 
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8.10.3 Linking the RAS Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select RAS-Base for Real 

Time forecasting (Figure 8.31).  The Model Linking Editor table (Figure 8.32) will now 
contain all of the locations for the RAS model alternative that need to be linked. The 
current linking (Figure 8.32) that is displayed for the RAS model alternative is the linking 
for the standalone model. 

 

 
Figure 8.32  Model Linking Editor - RAS Model Alternative Unlinked 

 
 2. RAS linking will be results from the HMS and ResSim model alternatives. The printout 

(RussianRiverLinking.pdf) of the linking for each of the model alternatives is located in a 
folder titled RussianRiver_Data. 

 
 3. From the Model Linking Editor (Figure 8.32), click Default Model to Link.  The 

Select Default Model to Link dialog box will open (Figure 8.33).  From the Default 
Model to Link list, select HMS-(RUN)Feb_1986.  Click OK, the Select Default Model 
to Link dialog box will close (Figure 8.33). 

 

 
Figure 8.33  Select Default Model to Link Dialog Box 

 
 4. A Confirm Input From Model changing to window (Figure 8.34) will appear. 

Basically the window is asking the user to be sure before proceeding, click Yes. The 
Confirm Input From Model changing to window closes, and the Model Linking 
Editor now displays the linking for the RAS model alternative (Figure 8.35). 
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Figure 8.34  Confirm Input From Model changing to window 

 

 
Figure 8.35  Model Linking Editor - Completed RAS Model Alternative Linking 

 
 5. There are two locations in the RAS linking that need to be linked to the ResSim model 

alternative.  From the Model Linking Editor table (Figure 8.35) for the DryCreek 
DryCreek RS 74716.8 (Sonoma Outflow J) row, from the Input Model column (Figure 
8.35), select ResSim-calibrate. HEC-WAT tries to find a match, Lake Sonoma-Pool - Net 
Inflow.  So from the Location/Parameter column list, select Lake Sonoma Outflow JCT 
- Flow. 

 
 6. Repeat Step 5 for the Russian CoyoteToDC RS 527387.7 (Lake Mendocino O) row (Lake 

Mendocino - Flow) to Lake Mendocino Outflow JCT - Flow. 
 
 7. The printout (RussianRiverLinking.pdf) of the linking for each of the model alternatives 

is located in a folder titled RussianRiver_Data.  Once the linking is finished for the RAS 
model alternative, from the Model Linking Editor (Figure 8.35) click     , this will save 
the linking. 

 
 7. That completes the linking for the RAS model alternative. 
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8.10.4 Linking the FIA Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select FIA-

GridsAndXSecsAlternative (Figure 8.35).  The Model Linking Editor table (Figure 8.36) 
will now contain all of the locations for the FIA model alternative that needs to be linked. 

 

 
Figure 8.36  Model Linking Editor - Completed FIA Model Alternative Linking 

 
 2. For FIA the linking will be results from the RAS model alternative. The printout 

(RussianRiverLinking.pdf) of the linking for each of the model alternatives is located in a 
folder titled RussianRiver_Data. 

 
 3. As the user can see the linking for the FIA model alternative in this study is already 

completed.  This is because the RAS and FIA model alternatives have already been 
linked in standalone mode.  

 
 4. For this example, the user will need to adjust two rows for the FIA linking; HEC-WAT 

did not choose the correct locations. In Figure 8.36, for the first row (DryCreek DryCreek 
74716.8), change the Location/Parameter column to DryCreek Dry Creek 74716.8 
(Sonoma Outflow J) - Stage.  Repeat for the row Russian CoyoteToDC 527387.7 and 
change the Location/Parameter column to Russian CoyoteToDC 527387.7 (Lake 
Mendocino O) - Stage. 

 
 5. Once the linking is finished for the FIA model alternative, from the Model Linking 

Editor (Figure 8.36) click     , this will save the linking. 
 
 6. That completes the linking for the FIA model alternative. 
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8.11 Compute and Results 
 
Now that a simulation has been defined, the linking of model alternatives has been completed for 
a simulation, and model alternatives have been imported into HEC-WAT, the user is now ready 
to compute the Russian River study. 
 
 1. From the HEC-WAT main window (Figure 8.37), from the Study Tree, from the 

Simulations folder, right-click Without Project Conditions-RR_Feb1986. From the 
shortcut menu (Figure 8.37) point to Compute, hold down the Ctrl key, click 
Simulation. 

 

 
Figure 8.37  HEC-WAT Main Window  - Compute 

 
 
 2. The Compute Progress dialog box will open (Figure 8.38) and the compute starts.  Since 

the user is taking a watershed that was built for real-time forecasting (CWMS) and 
creating a planning study (HEC-WAT) from those models, the user may need to do some 
work on getting the models to compute successfully. 
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Figure 8.38  Compute Progress Dialog Box 
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Chapter 9  
 

Flood Risk Analysis (FRA) Compute 
Option 
 
USACE flood risk management (FRM) policy requires that USACE analytical processes include 
methods and tools that employ integrated, comprehensive, systems and life-cycle based 
approaches and risk-based concepts in planning, design, construction, operations and major 
maintenance. These USACE methods need to incorporate systems response of projects when 
considering load distribution and failure possibilities. USACE policy also states that project 
performance needs to consider the system reaction to flood loading and how those loadings are 
distributed across the watershed.  
 
HEC-WAT includes an option that will analyze complex riverine systems while implementing 
the flood risk management and systems requirements.  The compute option, Flood Risk Analysis 
(FRA), allows a user to perform plan formulation or system performance analyses while 
incorporating risk analysis. 
 
9.1 Create an HEC-WAT Study 
 
To create an HEC-WAT study by importing from individual models, the first step is to create an HEC-
WAT study: 
 
 1. From the HEC-WAT main window (Figure 9.1), on the File menu, click New Study. The 

Create New Study dialog box (Figure 9.2) will open. 
 

 
Figure 9.1  HEC-WAT Main Window 
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Figure 9.2  Create New Study Dialog Box 

 
 2. In the Study Name box (Figure 9.2), enter a name (RussianRiver), and in the 

Description box, enter a description (Russian River water resources study - FRA) for the 
new study. 

 
 3. In the Directory box (Figure 9.2), either enter the name of the directory where the HEC-

WAT study will be stored, or click     , and an Open browser (Figure 9.3) will open.  
Navigate to the directory where the HEC-WAT study will be stored. 

 

 
Figure 9.3  Open Browser 



HEC-WAT Quick Start Guide Chapter 9 - Flood Risk Analysis (FRA) Compute Option 

 9-3 

 4. The Unit System for the study defaults to English (which is correct for the RussianRiver 
study).  The other choice from the list is SI (metric). 

 
 5. Next, the projected coordinate system of the study needs to be set.  From the Create New 

Study dialog box (Figure 9.1), click Edit (by the Coordinate System box), the Map 
Coordinate Information dialog box will open (Figure 9.4). 

 

 
Figure 9.4  Map Coordinate Information Dialog Box 

 
 6. For the RussianRiver study, the associated map layers have the correct projected 

coordinate system.  So, use one of those map layers to set the projected coordinate system 
for the study.  From the Map Coordinate Information dialog box (Figure 9.4), click 
Load from file (lower left corner of dialog box); an Open browser (Figure 9.3) will 
open. The map layers for the RussianRiver study are located in a folder titled 
RussianRiver_Data (double-click).  In that folder, is a MapLayers (double click) folder, 
from that folder, click on RR_StreamAlignment.prj (any of the map layers will work). 
Click Open, now the Map Coordinate Information dialog box will contain information 
about the projected coordinate system (Figure 9.4).  Click OK, the Map Coordinate 
Information dialog box will close (Figure 9.4).  Now on the Create New Study dialog 
box the Coordinate System box (Figure 9.2) contains the name of the projected 
coordinate system (i.e., USA_Continguous_Albers_Equal_Area_Conic_USGS_version) 
for the study. 

 
 7. Click OK; the Create New Study dialog box will close (Figure 9.1).  The HEC-WAT 

main window will now have the name of the study (RussianRiver) on the title bar (Figure 
9.5).  A blank Schematic Map Window opens. 
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Figure 9.5  HEC-WAT Main Window - RussianRiver Study 

 
9.2 Import an HEC-ResSim Model 
 
If there is an HEC-ResSim model available, the user should import that model first.  Why? 
Because the HEC-ResSim model will contain a stream alignment, all of the common 
computation points (CCPs), and the reservoirs necessary to model the watershed.   
 
 1. From the HEC-WAT main window (Figure 9.5), from the File menu, point to Import, 

and click ResSim.  An Import Type window (Figure 9.6) will open. Since the 
RussianRiver study being built does not have any of the basic building blocks that are 
covered in Chapter 6, click Watershed. 

 

 
Figure 9.6  Import Type Window 

 
 2. The Select Watershed File to Import From (Figure 9.7) browser will open.  Browse to 

the folder FRA_RR_Models; double click on the base folder; double-click on the 
RR_ResSim_Model folder.  From the Files of Type list, select ResSim Watershed Files; 
click RussianRiver.wksp; and, then click Open. 
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Figure 9.7  Select Watershed File to Import From Browser 

 
 3. A ResSim Import window will open (Figure 9.8) showing the progress of the HEC-

ResSim import. 
 

 
Figure 9.8  ResSim Import Window 

 
 4. The HEC-WAT Schematic Editor will open (Figure 9.9), from the Measures area of the 

Schematic Editor, click Select All.  All of the reservoirs listed in the table are now 
selected. Click OK, the Schematic Editor will close (Figure 9.9). 

 
 5. The imported stream alignment, common computation points, reservoirs, and any 

available map layers from the HEC-ResSim model display in the HEC-WAT Schematic 
Map Window (Figure 9.10). For all of the map layers to appear, close the Schematic 
Map Window, from the message window click Yes.  To re-open the Schematic Map 
Window, from the Study Tree, double-click on Schematic: Without Project Conditions, 
the Schematic Map Window will appear in the Desktop Area of the HEC-WAT main 
window (Figure 9.10). 

 
 6. The user has now completed the import of the RussianRiver HEC-ResSim model. 
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Figure 9.9  Schematic Editor 

 
 

 
Figure 9.10  HEC-WAT Schematic Map Window After HEC-ResSim Import 
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9.3 Import an HEC-HMS Model 
 
 1. From the HEC-WAT main window (Figure 9.5), from the File menu, point to Import, 

and click HMS.  The HEC-HMS application will open along with the Select Project File 
browser (Figure 9.11).   

 

 
Figure 9.11  HEC-HMS Main Window and Select Project File Browser 

 
 2. Browse to the folder FRA_RR_Models; double click on the RR_HMS_Model folder, 

select Russian_River.hms and, then click Select. 
 
 3. When the HEC-WAT study is created an hms subfolder is created.  In that subfolder are 

the default files that are generated when creating an HEC-HMS project.  When the HEC-
HMS import process finds that a project already exists, a warning window will appear 
(Figure 9.12).  Click Yes, the warning window will close. 

 

 
Figure 9.12  HEC-HMS Warning Window about HEC-HMS Project 

 
 4. The import process begins (patience this could take a few seconds), the import is finished 

when the study pane in the HEC-HMS main window contains a study tree. From the 
HEC-HMS main window (Figure 9.11), from the File menu, click Exit.  The HEC-HMS 
model import is completed. 
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9.4 Import an HEC-RAS Model 
 
 1. From the HEC-WAT main window (Figure 9.5), from the File menu, point to Import, 

and click RAS.  The Select RAS project to import from browser open (Figure 9.13).   
 

 
Figure 9.13  Select RAS project to import from Browser 

 
 2. Browse to the folder FRA_RR_Models; double click on the RR_RAS_Model folder, select 

RussianRiver.prj and, then click Open. 
 
 3. The Select RAS project to import from browser will close (Figure 9.13). An Importing 

window (Figure 9.14) will open; when the HEC-RAS model import is complete this 
window will close.  The HEC-RAS model import is completed. 

 

 
Figure 9.14  HEC-RAS Importing Window 

 
9.5 Import an HEC-FIA Model 
 
 1. From the HEC-WAT main window (Figure 9.5), from the File menu, point to Import, 

and click FIA.  The Import Alternatives dialog box will open (Figure 9.15); this dialog 
box can open behind the HEC-WAT main window.   
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Figure 9.15  Import Alternatives Dialog Box 

 
 2. Click Select/Add Project, an Open Browser will open (Figure 9.3).  Browse to the 

folder FRA_RR_Models; double click on the RR_FIA_Model folder, select 
RussianRiver.prj and, then click Open. 

 
 3. The table will now contain the name of the Project (RussianRiver).  From the 

Alternative column (Figure 9.16), from the list select the HEC-FIA alternative that will 
be imported (GridsAndXSecsAlternative). 

 

 
Figure 9.16  HEC-FIA Import Alternative Table 

 
 4. Click Edit Alternative Specifications, the Alternative Specification dialog box will 

open.  Select Copy Projection from project, and click OK. 
 
 5. Click Import Alternatives, in the Progress column of the table (Figure 9.16) the cell 

will display the progress of the import with a green bar.  When the import is complete an 
Information window will open, click OK. 

 
 6. From the Import Alternatives dialog box (Figure 9.15) click Close.  The HEC-FIA 

model alternative has been imported. 
 
9.6 Add Map Layers 
 
Now that the base models have been imported into the study lets add some map layers: 
 
 1. From the HEC-WAT main window (Figure 9.5), from the Maps menu, click Add Map 

Layers, the Select Map to Add browser will open (Figure 9.17).  Click Create Copy.  
Browse to the folder RussianRiver_Data; double click on the MapLayers folder, select 
the following map layers: 
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Figure 9.17  Select Map to Add Browser 

 
 ● Find the map layer which represents the impact areas - RR_ImpactAreas.shp 
 ● Find the map layer which represents the CCPs - RR_CommonComputationPoints.shp 
 
 2. Click Open, the Select Map to Add browser will close (Figure 9.17).  The HEC-WAT 

Schematic Map Window (Figure 9.18) will now display the added map layers. 
 
 3. The user can now make adjustments to the map layers.  From the HEC-WAT main 

window (Figure 9.5), click the Maps tab.  From the Map Layers tree: 
 
 ● Right-click on the Stream Alignment layer, from the shortcut menu, click Move to 

Top. 
 
 ● Right-click on the Without Project Conditions layer, from the shortcut menu, click 

Move to Top. 
 
 ● Un-check the Raingages_Albers_ft.shp map layer (this will cause the map layer to 

no longer display in the active map window). 
 
 ● Right-click on the RR_ImpactAreas.shp map layer, from the shortcut menu, click 

Properties.  The Edit Polygon Properties Editor will open (Figure 9.19).  From 
the Fill Tab, change the color to "lightgreen", click OK.  The impact areas on the 
active map window will now display in "lightgreen". 

 
 4. The user can adjust the view of the study area in the active map window.  Using the 

Magnifier Tool, zoom the study area in the active map window the appropriate area that 
the user would like displayed.  From the HEC-WAT main window (Figure 9.5), from the 
Maps menu, click Default Map Properties, the Default Map Properties for dialog box 
will open (Figure 9.20).  Click Set Map Extents to Display, click OK.  The Default 
Map Properties for dialog box will close. 
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Figure 9.18  Map Layers Added to Watershed 

 

 
Figure 9.19  Edit Polygon Properties Editor 
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Figure 9.20  Default Map Properties for Dialog Box 

 
This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 

 
9.7 Define Plug-Ins for an FRA Study 
 
To define the plug-ins for the RussianRiver study: 
 
 1. From the HEC-WAT main window (Figure 9.5), from the File menu, click Study 

Details. 
 
 2. The Study Details dialog box (Figure 9.21) will open. Click on the Plug-ins tab. The 

table that is displayed provides information on the plug-ins that are available in for the 
study. 

 
 3. For an FRA study, all plug-ins should be selected.  Click OK, the Study Details dialog 

box will close (Figure 9.21).   
 
9.8 Hydrologic Sampling 
 
The first step in an FRA compute (Monte Carlo analysis) is the sampling of the hydrology to 
create perhaps thousands of realizations of a hydrologic sequence.  Because FRA is an event-
based model, the hydrology information is needed as time series of flow or precipitation to be 
routed through the system under study.  Life-cycle analysis requires each realization of 
hydrology to consist of a full analysis period, for example fifty years, although a single year 
analysis period is also possible.  Realizations may be formed as flow hydrographs, or may be 
formed as precipitation hyetographs, with hydrographs generated by HEC-HMS within each 
FRA sub-compute.  Each realization of the analysis period will only be populated by the flood 
events, and not the low flow periods between flood events. 
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Figure 9.21  HEC-WAT – Study Details Dialog Box - Plugins Tab 
 
Hydrologic Sampling generates the hydrologic sequences required for the sampling of the 
hydrology.  Then hydrologic information such as flow or precipitation frequency curves, cross 
correlations between curves, and hydrograph or hyetograph shapes, or historical and synthetic 
event hydrographs is stored.  The Hydrologic Sampling then generates pseudo random numbers 
to sample the hydrology to generate as many realizations of the life-cycle hydrologic sequence as 
necessary.  Each generated sequence is made available to the other software applications 
available in the HEC-WAT program sequence. 
 
9.8.1 Creating a Hydrologic Sampling Alternative 
 
The following is for creating a simple hydrologic sampling alternative from a hydrologic 
sampling alternative that has already been created.  For further details review the HEC-WAT 
User's Manual. 
 
9.8.2 Copying a Hydrologic Sampling Alternative 
 
 1. With the HEC-WAT software closed, from the user's computer, locate the HEC-WAT 

directory for the watershed.  From the FRA_RR_Models folder, copy the RR_hs folder to 
the HEC-WAT directory that contains the study.  Rename that folder to hs. 
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 2. Open HEC-WAT, and open the RussianRiver study. 
 
 3. From the Study Pane (Figure 9.22), expand Models.  There should be a Hydrologic 

Sampling node, click on it.  In the Content Pane (below the Study Pane), there should 
be a Hydrologic Sampling Alternative - RR_Precip2. 

 

 
Figure 9.22  Study and Content Panes 

 
 4. Right-click on RR_Precip2, from the shortcut menu click Edit.  The Hydrologic 

Sampling Editor will open (Figure 9.23). 
 
 5. RR_Precip2 is a hydrologic sampling alternative that was previously built for the Russian 

River study.  This alternative is setup to sample precipitation data. How do we know that 
(besides the name)? From the Data to be Sampled list on the Hydrologic Sampling 
Editor (Figure 9.23), Precipitation Sampling has been selected.  The other choice is 
Flow Sampling.  For Precipitation Sampling there is one sampling method available 
(Sampling Method list, Figure 9.23), Basin Average Frequency Curve. 

 
 6. For Flow Sampling, there are two sampling choices (Sampling Method list, Figure 

9.23) - Basin Average Frequency Curve (which is the selection for RR_Precip2) and 
Historical Basin-wide Events.  Each of these choices are the mechanisms that generate a 
hydrologic sequence. 

 
 ● Basin Average Frequency Curve - generates an event hydrograph for each location 

by sampling a peak flow from a flow frequency curve and combining that peak with 
a hydrograph shape (for further details see HEC-WAT User's Manual and 
Applications Guide). 
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Figure 9.23  Hydrologic Sampling Editor - Event Sampling Tab 

 
 ● Historical Basin-wide Events - the period-of-record of actual events plus an array 

of synthetic events are put into a "flood bucket" and repeatedly re-sampled to 
provide basin-wide sets of hydrographs (for further details see HEC-WAT User's 
Manual and Applications Guide). 

 
9.9 Create an Analysis Period 
 
An FRA compute requires an HEC-WAT alternative, an analysis period, a program order, and 
model alternatives.   
 
To create an analysis period: 
 
 1. From the HEC-WAT main window (Figure 9.5), from the Study Tree, right click on the 

Analysis Periods folder (Figure 9.24).  From the shortcut menu click New.  
 

 
Figure 9.24  Analysis Period Shortcut Menu 
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 2. The Create New Analysis Periods dialog box will open (Figure 9.25).  In the Name box 
enter a name (FRA_TW).  In the Time Window box enter the information required for 
the time window. 

 

 
Figure 9.25  Create New Analysis Periods Dialog Box 

 
 3. For the Start Date and End Date, enter in the format ddmmmyyyy.  The Start Time and 

End Time should be entered as military time - e.g. 0000, 0600, 1300 (1 p.m.), 2400 
(midnight) 

. 
 4. Click OK, the Create New Analysis Periods dialog box will close (Figure 9.26).  On the 

HEC-WAT main window (Figure 9.5), from the Study Pane, under the Analysis Periods 
folder, the new analysis period name will appear. 

 
9.10 Setup Lookback Window – HEC-ResSim 
 
The time window for an HEC-ResSim run has two parts, a "lookback period" and a "simulation 
or forecast period".  The lookback period is used by HEC-ResSim to "warm up" a ResSim model 
alternative.  During this period, routing of flows through the river and reservoir network are 
performed but no release decisions are made nor are any mass balance computations evaluated.  
The user should think of the lookback period as the time to establish the state of the river 
network and the starting conditions of the reservoirs.  The simulation period is the portion of the 
time window during which HEC-ResSim simulates reservoir operations, and makes release 
decisions based on the operation scheme defined by the user.  Releases are then routed through 
the river network, combining with local inflows along the way.   
 
Since HEC-WAT and most of the models treat the analysis period as a single, continuous time 
window. For this reason a setup step is required for each HEC-ResSim alternative in an HEC-
WAT study.  The setup step lets each ResSim model alternative know how much of the analysis 
period to use for the lookback period.   
 
To setup the lookback period: 
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 1. From the HEC-WAT main window (Figure 9.5), from the Edit menu, point to ResSim, 

click Lookback Window (Figure 9.26). 
 

 
Figure 9.26  Edit Menu – ResSim – Lookback Window 

 
 2. The Lookback Window dialog box (Figure 9.27) will open. 
 

 
Figure 9.27  Lookback Window Dialog Box 

 
 3. The table displays the ResSim model alternative that are available in the HEC-WAT 

study.  Each model alternative that is being used in an HEC-WAT simulation will need to 
have a lookback window set.   For example, in Figure 9.27, the HEC-ResSim alternative 
calibrate has a TimeStep of 1 hour and Lookback Steps of 6. 

 
 4.   The time step can be selected from the TimeStep column, in each cell there is a list of 

available time steps for the user to choose from.  The selected time step has to match the 
time step that was specified for the ResSim model alternative as part of the alternative's 
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original run control data (which is located in the HEC-ResSim Alternative Editor). The 
number of lookback steps must be entered in a cell in the Lookback Steps column. At 
least one lookback time step is required for a ResSim model alternative to compute, 
however more lookback steps may be needed, depending on a variety of factors in the 
ResSim model alternative's operating scheme.  The HEC-ResSim modeler should be 
consulted to determine the minimum lookback window needed by each alternative. 

 
9.11 Program Order 
 
HEC-WAT allows for a flexible set of programs, computation order, and data flow through the 
establishment of a program order.  Once a program order has been chosen for an HEC-WAT 
study, changes should not be made to the program order as this could cause a disruption in the 
flow of data and invalidate any existing work. 
 
Currently in HEC-WAT Version 1.0 the default program order is - HMS, ResSim, RAS, FIA.  
This is the correct program order for the example watershed that is being used, so no adjustment 
is necessary.  For further details on Program Order, review Chapter 11 (Section 11.1) of the 
HEC-WAT User's Manual. 
 
9.12 Create an HEC-WAT FRA Simulation 
 
Now that all of the building blocks have been configured, the user can now create an HEC-WAT 
FRA simulation.  To create an HEC-WAT FRA simulation: 
 
 1. From the HEC-WAT main window (Figure 9.5), from the WAT Tools toolbar, click the 

Alternative and Simulation Manager button       . 
 
 2. The Alternative and Simulation Manager dialog box will open (Figure 9.28).  From 

this dialog box the user can create/modify alternatives, analysis periods, simulations, 
program order, link models, and make runs. 

 

 
Figure 9.28  Alternative and Simulation Manager Dialog Box 
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 3. To create a simulation, from the table right-click on the intersection of an alternative and 
analysis period.  From the shortcut menu click Create Simulation.  The Create New 
Simulation dialog box will open (Figure 9.29). 

 

 
Figure 9.29  Create New Simulation Dialog Box 

 
 4. HEC-WAT has defined a default name for the simulation (Without Project Conditions-

FRA_TW) in the Name box (Figure 9.29).  The name is a combination of the HEC-WAT 
alternative name and analysis period name, where the intersection was in the table (name 
can be changed).  Also, in the Alternative and Analysis Period lists (Figure 9.29) the 
selections have already been made based on the intersection in the table.  The selected 
Alternative cannot be changed, but the selected Analysis Period can be changed. 

 
 5. In the F Part box (Figure 9.29), a default F Part is displayed that was generated by 

HEC-WAT based once again on the alternative and analysis period. The user can edit the 
item, but it is not advised. 

 
 6. To create an FRA simulation, select Run FRA (Figure 9.30).  The options for setting up 

an FRA simulation are now available. 
 

 
Figure 9.30  FRA Setup - Create New Simulation Dialog Box 
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 ● Number of realizations to perform the flood risk management analysis - enter 
the maximum number of realizations (e.g., 10) that are needed to perform the FRA 
analysis; number must be equal to or larger than the simulation time window.  

 
 ● Years per realization - default is 500; number can be increased.  
 
 7. From the Hydrologic Event Alternative list (Figure 9.30) select the appropriate 

Hydrologic Sampling Alternative (RR_Precip2). 
 
 6. A program order needs to be selected.  From the Program Order list (Figure 9.30) select 

the Default program order. 
 
 8. In the Programs table (Figure 9.31), the software applications that were defined in the 

program order appear in the order the software applications were selected.  Now the user 
must select the appropriate alternative (plan, run) for each software application. From the 
Alternative column, from the list for HMS (Figure 9.31), select the appropriate HMS run 
((MCA)DCL_WAT).  Repeat the process for the other software applications. Below is the 
list of the appropriate alternatives for the RussianRiver study: 

 

 
Figure 9.31  Selection of Model Alternatives - Create New Simulation Dialog Box 

 
 HMS - (MCA)DCL_WAT 
 ResSim - calibrate 
 RAS - Base 
 FIA - GridsAndXSecsAlternative 
 
 9. Now that all of the alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 9.28).  On the Alternative and Simulation 
Manager (Figure 9.32) dialog box, the intersection of the alternative and analysis period 
now provides information about the simulation. 

 
 10. Click OK; the Alternative and Simulation Manager dialog box will close (Figure 

9.32).  From the HEC-WAT main window (Figure 9.5), the created simulation appears on 
the Study Tree, under the Simulations folder (Figure 9.33). 

 
 11. Click on the simulation in the Study Tree (Figure 9.33), the Content Pane (Figure 9.34) 

displays information about the selected simulation. 
 
 12. Double-click on the simulation name (Without Project Conditions-FRA_TW), a Select 

Map dialog box will open. Click New Map Window, click OK. The Select Map dialog 
box will close.  The new map window will contain the schematic elements that represent 
the simulation (Figure 9.35). 
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Figure 9.32  Alternative and Simulation Manager - Completed Simulation 

 

 
Figure 9.33  Study Tree with Created Simulation 

 

 
Figure 9.34  Content Pane 
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Figure 9.35  Map Window - Schematic of Current HEC-WAT Simulation 

 
9.13 Linking 
 
The next step is to have the models of a simulation communicate with each other.  This is 
accomplished by linking (DSS mapping) the models thru DSS and using a simulation name.  
From HEC-WAT, the Model Linking Editor (Figure 9.36) provides an easy way to link models 
including observed data, and provides a mechanism where the linking will have to be done once 
per alternative. 
 

 
Figure 9.36  Model Linking Editor 
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 1. From the HEC-WAT main window (Figure 9.35), from the WAT Tools toolbar, click the 

Model Linking Editor button        . 
 
 2. The Model Linking Editor will open (Figure 9.36).  From the Simulation list the user 

will need to select a simulation.  For this example the user will be selecting the Without 
Project Conditions-FRA_TW (default) simulation. 

 
 3. Now let's link the individual model alternatives that are part of the selected simulation. 
 
9.13.1 Linking the HMS Model Alternative 
 
 1. From the Model Linking Editor (Figure 9.36), from the Model to Link list select HMS-

(MCA)DCL_WAT (Figure 9.37).  The Model Linking Editor table will now contain all 
of the locations for the HEC-HMS model that need to be linked. 

 

 
Figure 9.37  Model Linking Editor - HMS Model Alternative Unlinked 

 
 2. For HEC-HMS the linking will be results from the Hydrologic Sampling alternative. The 

printout (RussianRiverLinking.pdf) of the linking for each of the model alternatives is 
located in a folder titled RussianRiver_Data. 

 
 3. Does every row in the table have to be done? Yes, but, since all of the linking will be to 

the Hydrologic Sampling alternative, click Default Model to Link.  The Select Default 
Model to Link dialog box will open (Figure 9.38).  From the Default Model to Link 
list, select HydrologicSampling-RR_Precip2.  Click OK, the Select Default Model to 
Link dialog box will close (Figure 9.38). 
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Figure 9.38  Select Default Model To Link Dialog Box 

 
 4. A Confirm Input From Model changing to window (Figure 9.39) will appear. 

Basically the window is asking the user to be sure before proceeding, click Yes. The 
Confirm Input From Model changing to window closes, and the Model Linking 
Editor now displays the linking for the HEC-HMS model (Figure 9.40). 
 

 
Figure 9.39  Confirm Input From Model changing to Window 
 

 
Figure 9.40  Model Linking Editor - Completed HMS Model Alternative Linking 

 
 5. Once the linking is finished for the HMS model alternative, from the Model Linking 

Editor (Figure 9.40) click     , this will save the linking. 
 
 6. That completes the linking for the HMS model alternative. 
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9.13.2 Linking the ResSim Model Alternative 
 
 1. From the Model Linking Editor (Figure 9.40), from the Model to Link list, select 

ResSim-calibrate.  The Model Linking Editor table (Figure 9.41) will now contain all of 
the locations for the ResSim model alternative that needs to be linked. 

 

 
Figure 9.41  Model Linking Editor - ResSim Model Alternative Unlinked 

 
 2. For ResSim the linking will be the results from the HMS model alternative. Well, this 

looks like it is already linked.  Well, yes and no. The HEC-ResSim model was already 
part of another HEC-WAT study.  The model was modified to include parameter 
sampling. So the Model Linking Editor is reading the ResSim linking and it's reporting 
that this HEC-ResSim model alternative is already linked to an HMS model alternative 
that HEC-WAT knows about and it was linked to a different HEC-WAT simulation. 

 
 3. Does every row in the table have to be done? Yes, but, since all of the linking will be to 

the HMS model alternative, click Default Model to Link.  The Select Default Model to 
Link dialog box will open (Figure 9.38).  From the Default Model to Link list, select 
HMS-(MCA)DCL_WAT.  Click OK, the Select Default Model to Link dialog box will 
close (Figure 9.38). 

 
 4. A Confirm Input From Model changing to window (Figure 9.39) will appear. 

Basically the window is asking the user to be sure before proceeding, click Yes. The 
Confirm Input From Model changing to window closes, and the Model Linking 
Editor now displays the linking for the ResSim model alternative (Figure 9.42). 
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Figure 9.42  Model Linking Editor - Completed ResSim Model Alternative Linking 

 
 5. Once the linking is finished for the ResSim model alternative, from the Model Linking 

Editor (Figure 9.42) click     , this will save the linking. 
 
 6. That completes the linking for the ResSim model alternative. 
 
9.13.3 Linking the RAS Model Alternative 
 
 1. From the Model Linking Editor (Figure 9.42), from the Model to Link list, select RAS-

Base.  The Model Linking Editor table (Figure 9.43) will now contain all of the 
locations for the RAS model alternative that needs to be linked.  

 
 2. For the RAS linking, results from the HMS and ResSim model alternatives will be used. 

The printout (RussianRiverLinking.pdf) of the linking for each of the model alternatives 
is located in a folder titled RussianRiver_Data. 

 
 3. From the Model Linking Editor (Figure 9.43), click Default Model to Link.  The 

Select Default Model to Link dialog box will open (Figure 9.38).  From the Default 
Model to Link list, select HMS-(MCA)DCL_WAT.  Click OK, the Select Default Model 
to Link dialog box will close (Figure 9.38). 

 
 4. A Confirm Input From Model changing to window (Figure 9.39) will appear. 

Basically the window is asking the user to be sure before proceeding, click Yes.  The 
Confirm Input From Model changing to window closes, and the Model Linking 
Editor now displays the linking for the RAS model alternative (Figure 9.44). 
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Figure 9.43  Model Linking Editor - RAS Model Alternative Unlinked 

 

 
Figure 9.44  Model Linking Editor - Completed RAS Model Alternative Linking 

 
 5. There are two locations in the RAS linking that needs to be linked to the ResSim model 

alternative.  From the Model Linking Editor table (Figure 9.43) for the DryCreek 
DryCreek RS 74716.8 (Sonoma Outflow J) row, from the Input Model column (Figure 
9.43), select ResSim-calibrate, select Lake Sonoma Outflow JCT - Flow. 

 
 6. Repeat Step 5 for the Russian CoyoteToDC RS 527387.7 (Lake Mendocino Outflow JCT - 

Flow) row. 
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 7. Once the linking is finished for the RAS model alternative, from the Model Linking 
Editor (Figure 9.44) click      , this will save the linking. 

 
 8. That completes the linking for the RAS model alternative. 
 
9.13.4 Linking the FIA Model Alternative 
 
 1. From the Model Linking Editor, from the Model to Link list select FIA-

GridsAndXSecsAlternative (Figure 9.44).  The Model Linking Editor table (Figure 9.45) 
will now contain all of the locations for the FIA alternative model that needs to be linked. 

 

 
Figure 9.45  Model Linking Editor - Completed FIA Model Alternative Linking 

 
 2. For FIA, the linking will be the results from the RAS model alternative. Specifically 

depth grids that have been created by the RAS Mapper Tool available from HEC-RAS. 
 
 3. From the Model Linking Editor (Figure 9.45), from the Input From Model column, 

from the model list, select RAS-Base.  In the Location/Parameter column, HEC-WAT 
has identified what it thinks is the correct item - Depth (Max)1 - depth and HEC-WAT is 
correct. 

 
 4. Once the linking is finished for the FIA model alternative, from the Model Linking 

Editor (Figure 9.47) click      , this will save the linking. 
 
 5. That completes the linking for the FIA model alternative. 
 
9.14 Output Variables 
 
The user must choose at least one output variable from the model alterantives in the compute 
sequence or tell the FRA simulation to compute without an output variable being chosen before 
computing an FRA simulation (Section 9.15).  For a "production" simulation where output is  
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required, the user should choose all appropriate output variables before running the simulation.  
Why is it a good idea for the user to choose at least one output variable?  In most cases, the 
desired type of output from a WAT/FRA simulation will include the maximum (or minimum) 
value from a time-series record.  For example, the maximum stage from a reservoir time-series 
could be extracted to build a reservoir stage frequency curve.  Saving time-series information 
from many thousands of events, at many locations, for many alternatives could overwhelm the 
available storage on a computer.  However, maximum values (scalars) do not require much disk 
space.  From the Output Variable Editor (Figure 9.46), a user can select any available output 
variables from the models that are part of the selected HEC-WAT simulation and get summary 
information (e.g., maximum flows, maximum stage, etc.) for each event in the FRA compute. 
 

 
Figure 9.46  Output Variable Editor 
 
 1. From the HEC-WAT main window (Figure 9.35), from the WAT Tools toolbar, click 
       . 
 
 2. The Output Variable Editor will open (Figure 9.46).  From this editor, the user can 

select variables from the model alternatives that are part of a selected HEC-WAT 
simulation.  Currently, the maximum value for each of the output variables selected will 
be saved to the simulation.dss file and if the user wants to generate a frequency curve for 
a selected output variable, the user must select Frequency from the Output Variable 
Editor (Figure 9.46). 

 
 3. From the Simulation list, select an HEC-WAT simulation (only FRA simulations will be 

available); next from the Model list select the appropriate software application; and, then 
from the Alternative list select the appropriate model alternative. 

 
 4. Next click Select Variables to Save, the Select model alternative selector will open 

(Figure 9.47). 
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Figure 9.47  Select model alternative Selector 

 
 5. A list of the model alternative's available output variables is listed in the Available 

Variables list.  To select one, highlight, and then click Add.  The selected variable is 
moved to the Selected Variables list.  Click OK, the Select model alternative selector 
(Figure 9.47) closes and the selected output variables appear on the Output Variable 
Editor (Figure 9.46). 

 
 6. From the File menu, click Save. Close the Output Variable Editor (Figure 9.46). 
 
9.15 Compute and View Results 
 
Now that a simulation has been defined, the linking of model alternatives has been completed for 
a simulation, and model alternatives have been imported into HEC-WAT, the user is now ready 
to compute the Russian River study. 
 
 1. From the HEC-WAT main window (Figure 9.35), from the Study Tree, from the 

Simulations folder, right-click Without Project Conditions-FRA_TW. From the shortcut 
menu (Figure 9.48) point to Compute, click Simulation. 

 
 2. The Run FRA Simulation dialog box will open (Figure 9.49).  In the Name box is the 

name of the simulation that will be computed (Without Project Conditions-FRA_TW).  
The number of realizations (10) that will be computed is provided in the Max. Number 
of Realizations box.  Other options are: 

 
 ● Start at Lifecycle 1 - default starting point of an FRA compute 
 
 ● Run specified - by selecting this option the user can choose whether to run from a 

specific lifecycle or realization.  From the Run Specified List (Figure 9.49) the user 
can select lifecycle or realization.  In the text box the user will then enter the number 
of the specific lifecycle or realization to start the FRA compute from. 
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Figure 9.48  HEC-WAT Main Window – FRA Compute 

 

 
Figure 9.49  Run FRA Simulation Dialog Box 
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 ● Save Lifecycle DSS Files - when the user makes this choice all FRA results are 

saved.  If the only results the user wants saved are by realization and lifecycle then 
the user should choose Delete Event Folders (Figure 9.49) to make sure results by 
events are not saved. 

 
 ● Save Model Folders – results by events are not saved by default; if the user wishes 

to save all information, Save Model Folders (Figure 9.49) must be selected 
 
 ● Stop Simulation Compute on Error - selecting this option will make the FRA 

compute stop when any kind of error is detected during the simulation (compute) 
 
 ● Output Variables Optional – by default an FRA compute requires that at least one 

output variable be selected; if Output Variables Optional is selected then output 
variables are not required for the FRA compute 

 
 ● Restart WAT After Model Errors – if Stop Simulation Compute on Error has 

not been selected, this option becomes available.  If this option is selected, the user 
can set the consecutive number of errors that will make HEC-WAT restart and the 
maximum number of restarts. 

 
 ● Restart Plugins - this allows the user to decided which programs to stop and re-start 

during the FRA compute.  This needs to be used when there are memory issues with 
the individual software applications during an FRA compute. 

 
 3. Click Next, the Run FRA Simulation Information dialog box (Figure 9.50) will open.  

This dialog box provides information about the FRA simulation that is about to be 
computed.  Information includes the time window, when the simulation will be stopped, 
whether results will be saved, lifecycles that will be run, convergence information, model 
sequence information, variables for convergence, time window modifiers; and output 
variable time windows. 

 
 4. Click Compute, the Compute Progress dialog box will open (Figure 9.51).  When the 

compute is finished, click Close, the Compute Progress dialog box will close (Figure 
9.51). 

 
 5. Since the user is taking a study that was built for a non-flood risk analysis, the user may 

need to do some work on getting the models to compute successfully. 
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Figure 9.50  Run FRA Simulation Information Dialog Box 

 

 
Figure 9.51  Compute Progress Dialog Box - FRA Compute 
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